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Terms 

This document is the result of an agreement from the following parties: 

● Disaster Management Innovation (DMInnovation) 
● Humanitarian OpenStreetMap Team (HOT) 

 

The contents and materials in this document may be subject to change without 

public notice. 

 

License 

 

All contents and materials in this module is public domain. You may copy, 

modify, distribute, and display this module, in its entirety without asking 

permission. 

 

For further information regarding public domain licensing: http://wiki.crea-

tivecommons.org/Publicdomain/zero/1.0/LegalText_(Indonesian) 
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About Us 

 

Disaster Management Innovation (Previously AIFDR) 

 

 

Disaster Management Innovation is the latest investment of the Australian Gov-

ernment through Geoscience Australia in Indonesia. DMInnovation is founded 

to continue the success of Australia - Indonesia Facility for Disaster Reduction 

(AIFDR), a former initiative between the Australian - Indonesian Government. 

AIFDR was launched ceremoniously by the Australian - Indonesian Govern-

ment on July 15, 2010 and was officially closed in August 2015. DMInnovation 

will continue to maintain scientific technical assistance which will be used in 

partnership programs between the scientific institution of Indonesia and Geosci-

ence Australia. 
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Humanitarian OpenStreetMap Team (HOT) 

 

 

 

Free and collaborative maps have its own unique value in humanitarian work, 

especially in places where basic maps are rare, containing old data, or fre-

quently change. Developed in two years of informal collaboration, Humanitar-

ian team of OpenStreetMap is a new initiative to apply the principles and activi-

ties of open source and open data sharing to achieve humanitarian response and 

economic development.  

 

https://www.hotosm.org/ 

http://openstreetmap.id 
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Chapter 1 

Introduction 

 
Learning Objectives 

• To understand the definition of OpenStreetMap 

• To understand the history of OpenStreetMap 

• To understand the difference between and other map providers 

• To understand OpenStreetMap sample products 

• To understand how OpenStreetMap works 

• To understand the concept of paper maps  

• To understand the importance of digital maps 

• To understand the components of digital maps 

 

1.1 What is OpenStreetMap? 
OpenStreetMap (OSM) is a tool to create and distribute information in a map. 

Anyone can contribute to OSM and thousands of people add new projects to 

OSM every day. Users make maps on their computer, instead of on a piece of 

paper, but as we are going to learn from this module, drawing maps on a 

computer is not too different from drawing it on a paper. We still use symbols, 

such as lines to draw roads and squares for buildings. However, what is 

important from OSM is that the maps you create will stored into the internet and 

anyone can access them anytime and anywhere for free. 
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Picture 1.1. OpenStreetMap 

1.2 OpenStreetMap History 
The two main factors that brings about the initiation and growth of OSM is the 

limited usage and availability of map information in many parts of the world 

and the affordability of portable satellite navigation software. 

Steve Coast began the project in 2004. He initially focused on mapping the 

United Kingdom. In the UK and other countries, government-funded projects, 

such as the Ordnance Survey, created a lot of datasets that cannot be freely and 

widely distributed. In April 2006, OpenStreetMap Foundation was established 

to encourage the growth, development, and the distribution of free geospatial 

data and to liberate such data to be used and shared by anyone. In December 

2016, Yahoo! confirmed that OpenStreetMap was allowed to use its satellite 

imagery as its map creation background. 

In April 2007, Automotive Navigation Data (AND) donated all its street datasets 

from the Netherlands and main roads datasets from India and China to this 

project. In July 2007, 9,000 users signed up to attend the first international 

conference State of the Map. This event was sponsored by Google, Yahoo, and 

Multimap. In September 207, OpenStreetMap started a datasets import process 

of the TIGER for the United States. In December 2007, Oxford University 

became the first major organization to use OpenStreetMap data in its website. 

The means to import and export data continued to develop. In 2008, the project 

launched a tool to export OpenStreetMap data into a portable GPS, that can 

replace copyrighted and obsolete maps in the inside. In February 2008, a series 

of OpenStreetMap workshops were organized in India. 



 

3 

In 2010, Microsoft let its satellite imagery to be used as a background satellite 

imagery for OpenStreetMap data entry. In 2012, Google Map is charging fees 

for its service triggered a number of reputable websites to convert from Google 

Maps into the OpenStreetMap and its other competitors. A few of these 

websites, including Foursquare, Craiglist who adopted OpenStreetMap, and 

Apple, Inc who terminated its contract with Google and launched its own 

independent mapping platform that uses TomTom and OpenStreetMap data 

(more information can be seen from: https://wiki.openstreetmap.org/). 

 

Picture 1.2. OpenStreetMap History 

 

1.3 Why Choosing OpenStreetMap? 
The following are some reasons why you are better-off choosing 

OpenStreetMap: 

1. OpenStreetMap is open and free. This means, OSM is not charging any fees 

to use its data. 

2. Data OpenStreetMap is rich, accurate, and updated real-time. This is 

because each user can add, change and delete data. For example: if you 
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realize a building no longer exist but is still mapped on OpenStreetMap, you 

can easily delete that building from the map. 

3. Using OpenStreetMap is easy. OpenStreetMap produces a lot of guidelines 

to first-time OSM mappers. Its layout and means to add data is made as easy 

as possible to enable users with diverse educational background can still 

participate in contributing data to OpenStreetMap. 

4. OpenStreetMap can be customized. All datasets in OpenStreetMap can be 

used to your own needs, for instance, if you need to make tourism sites map 

in your place, you can take OpenStreetMap data and show only these 

tourism destinations without having to include other information. 

Now that you understand the benefits of using OpenStreetMap, you may wonder, “how 

is OpenStreetMap better than other digital map providers?”. Below you can see a 

comparison between OpenStreetMap and other map providers using Map Compare by 

Geofabrik (http://tools.geofabrik.de/mc). 

 

Picture 1.3. Comparison between OpenStreetMap, Google Map, and Bing Map 

 

 

1.4 Samples of OpenStreetMap Usage 
OpenStreetMap data is open, which means anyone can access and contribute to 

adding OpenStreetMap data. OSM data can be used for a variety of purposes, using 

Geographic Information System (GIS), such as disaster management, urban planning, 

et cetera. 
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1. Making of Village Map 

The spatial data available to making village maps are often incomplete or not 

detailed. By using OpenStreetMap data, large scale maps, such as village maps 

can be created in detailed as contributors can do their own ground survey on the 

area in question.  

 
Picture 1.4. Example of Village Maps 

 

2. Making of Database for Disaster-prone Areas 

In disaster management, maps play critical roles in preparedness, response, and 

rehabilitation phases. Some of the map examples related to disaster 

management, including map of disaster prone areas, map of affected buildings, 

map planning for evacuation shelters and routes. 

 
Picture 1.5. Example of Map of Disaster Prone Areas 
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Picture 1.6. Example of Evacuation Route Map 

 

 
Picture 1.7. Example of Map of Affected Buildings 
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1.5 Basic Concepts OpenStreetMap 

 
1. The Concept of Paper Maps 

Information is an important element. With better information and the right 

understanding, each individual and citizen can improve their livelihood and make 

informed decisions for their future. There are a lot of decisions made by communities 

and organizations that can affect people’s life. This means having richer information 

may enable organizations, governments, and community in making better decision that 

can improve people’s livelihood. 

Picture 1.8. Satellite Imagery Layout 

Maps can be a good way to convey information. Maps are visual symbols of our world. 

Maps can often deliver information and answer questions better than words, for 

example where are nearest schools and hospitals? Who has the easiest access to those 

facilities? Where do we find issues with poverty? These questions are better addressed 

using maps to find the right solution. 

For an opening exercise, please prepare a pencil and a piece of paper, and then draw a 

map of the area you live in or are familiar with. What are the most important parts that 

need to be included in a map? What are the most critical parts of a map? Spend a few 

minutes on this exercise and once you are done, examine the maps and ask yourself 

questions, such as why is it important for this information to be included in a map and 

to whom will this information be useful? 
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Picture 1.9. Example of Maps Drawn on a Paper 

 

If you draw an area that you know really well, you may find yourself drawing lines as 

roads and waterways. You may also include buildings, such as schools and offices, 

courts or even administrative boundaries, such as village and neighborhood boundaries. 

Whatever you decided to draw, you must use symbols to represent the objects you fill 

in, such as lines for roads, and squares for buildings, et cetera. In a sense, the map you 

drew is a representation of what exists on the surface of the earth. 

 

Picture 1.10. Examples of Symbols Used on a Paper Map. 

 

The map you draw has to be informative. You may have to explain this map to someone 

who does not know the area you draw, to clarify what are the problems that exist in that 
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community, and to help someone who are trying to reach the location on that map. But 

of course, there are shortcomings in such maps, such as that you only draw one map, 

or that may be your drawing is not easy to comprehend by other people, or that because 

it is made on a paper, it is not easy to distribute it to other people. This what makes 

making maps on a computer or making it digitally is better solution to store and 

distribute maps that we make so it can easily be accessed by other people in need. 

2. Why Shifting into Digital? 

Digital maps are a representation of geographic phenomenon stored to be displayed and 

analyzed by a computer. In other words, digital maps are maps made by software with 

functions specific to making maps. Each object on a digital map is stored as one or a 

group coordinates. Data in digital maps, compared to paper maps, are easier to update 

and to store. 

Picture 1.11. Making A Digital Map 

Making maps on a computer enable us to collect more meaningful data compared to 

making it on a paper. On a piece of paper, we may be able to draw a school, add its 

name and record a couple of other information about that school, but in a computer, we 

can attach data on the size of students, teachers, size of buildings, structure of buildings, 

et cetera. More importantly, when we add this school into a digital map, we are 

recording it to the right location (latitude and longitude) on the earth. In addition, there 

are a few components we need to consider in making digital maps. 
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3. Components in a Digital Map 

Digital maps have several components, including: 

1. Projection System 

Every digital map needs to have a projection system. Map projection is a 

system that translate relations between the nodes on earth compared to the 

ones on the map. This is because the earth surface is not flat and irregular, 

making it difficult to represent the result of measurements. Ellipsoid with 

certain scales is then chosen as a geometry that can represent the earth’s 

physical form. 

2. Spatial Data 

Spatial data is data that has georeferenced in which a variety of attribute 

data is placed in spatial units. 

There are two types of spatial data, which are: 

1. Vector Data (nodes, lines, polygons) 

Vector data describes geographical data as points that have coordinates 

and can be linked to one another by lines and polygons. Each object in 

a vector dataset is called feature, and are linked with data that describe 

that feature. 

 
Picture 1.12. Types of Vector Data 

2. Raster Data (grid or pixel) 

Raster data is similar to images. Although it may represent a variety of 

objects in real life, these objects are inseparable and are represented by 

a pixel with different colors. 
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Picture 1.13. Illustrations of Rater Data 

 

3. Non Spatial Data 

Non Spatial data is a tabular (attribute) data linked to or is integrated to the 

characteristics or description of spatial data. For example, the name of the 

facility, address, population size, et cetera.  

Now that you understand the definition and history of OpenStreetMap, you have also 

learned the basic concept of the making of OpenStreetMap, one of which is by 

converting paper maps into digital maps. Having understood these concepts, you may 

be interested to find out more about OpenStreetMap and how to use it in daily life. 
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Chapter 2  

Start Using OpenStreetMap 
 

Learning Objectives 

●     To understand and to practice how to visit OpenStreetMap website 
●     To understand and to practice how to explore OpenStreetMap 

●     To understand and to practice how to change OpenStreetMap layers 

●     To understand and to practice how to look up object information on OpenStreetMap 

●     To understand and to practice how to save OpenStreetMap into images  

●     To understand and to practice how to share OpenStreetMap hyperlinks 

●     To understand and to practice how to create an OpenStreetMap account 

 

Having known what is OpenStreetMap, in this chapter we are going to learn further 

how to visit OpenStreetMap website and the menu it has. We will also learn and 

practice how to change layer, to look up object information, to save maps as images, 

and to share OpenStreetMap links. By the end of the chapter, we will learn how to 

create an OpenStreetMap account before we can add and update data in it. 

 

2.1 Visiting OpenStreetMap Website 
In order to visit OpenStreetMap website, make sure your computer is connected to the 

internet. You also need to make sure it has a web browser, such as Google Chrome, 

Mozilla Firefox, Internet Explorer, Opera, Safari, and alike. If you have them both, 

please follow the instruction below: 

1. Open the web browser in your computer, in the address bar above your browser, 

type www.openstreetmap.org and press enter; 

2. When the website appears, you will see the following screen: 
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Picture 2.1. OpenStreetMap Website’s Landing Page 

 

2.2 Navigating A Map 
On the main interface of the OpenStreetMap website, you will see one big map on a 

display. You must be able to navigate this map so you can explore the place of your 

choice. To zoom the map in and out, you can use (+) and (-) buttons located on the right 

side of your monitor. If your mouse has a scroll wheel, you can use that to zoom in and 

out. Scroll the mouse’s scroll wheel upwards to zoom in and downwards to zoom out. 

To drag the map display, you can use your mouse. Left click on your mouse, hold and 

drag it to the place you desire (see the Picture below for further information). 
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Picture 2.2 OpenStreetMap Menus and Their Functions. 

 

Picture 2.3 How to Navigate using Mouse 

To search the location, you can use the search bar on the left side of your monitor. You 

can type in the location name on that search bar, and then press “Enter”. A “search 

result” panel will appear below the search bar. You can select one of the search results 

displayed to head over directly to the place you intended. 
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Picture 2.4. Search Result on the OpenStreetMap 

 

2.3 Showing a Map with Different 
Layouts 
OpenStreetMap has geographic data from all over the world. Although stored in one 

database, those data can be shown in different layouts. To do that, you can click on the 

layer button on the right side of the map. 

 
Picture 2.5. A button to change the layer of OpenStreetMap  
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Click on each layer to see different layouts on your map. Each layer will show different 

layout. For example, transport map layer focuses more on transport routes, such as 

highways and bus lanes, while humanitarian layer will show public facilities, such as 

schools, hospitals, and office buildings. All these types of data can be included on the 

OSM.  

 
Picture 2.6. (Above) Humanitarian Layer (Below) Transport Layer 

  

  

2.4 Looking up for Object Information 
on OpenStreetMap 
On the main page of OpenStreetMap, other than to look for a location and navigating 

the map, we can also see the objects’ information using query features. The following 

are the steps: 
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Picture 2.7. The Button to Activate Query Features 

 

1. Click on the ‘Query Features’ on the right side of your monitor. A question 

mark will appear on the right side of your mouse cursor. This means the query 

features have been activated.   

2. Select objects or locations you need to identify. In this example, we will choose 

Placa Indonesia in Jakarta.  

3. A box will appear on the left side of the monitor to show Nearby Features and 

Enclosing Features. Nearby Features show the objects located closest to the 

object we select, while Enclosing Features show the objects located surround 

our selected object. Select the object information Plaza Indonesia. 

4. After you select that, detailed information about Plaza Indonesia will be shown 

on the left panel. 
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Picture 2.8 Object Identification Results using Query Features on the OpenStreetMap 

 

2.5 Exporting Maps into Images 
Other than changing layer on OpenStreetMap, you can also export that map as an 

image. Here is how to do that: 

1. Click on the label ‘Share’ on the icon located at the right side of your map. 

  

 
Picture 2.9. A Button to Export OpenStreetMap  
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2. Determine which area on the map you would like to export as an image. Tick 

the ‘Set custom dimensions’ box and then set the size of the box as you want 

or by adjusting the scales.  

3. Click ‘Download’. 

 
Picture 2.10. The Interface to Export OpenStreetMap 

 

2.6 Sharing OpenStreetMap Links 
You can share a link pointing at a location on OpenStreetMap to others for many 

reasons, for example when you want to share a location you are at right now to your 

colleague. To share OpenStreetMap, here are the steps: 

1. Click the icon ‘Share’ on the right panel of your monitor. 

2. A ‘Share’ panel will be displayed on the right side of your monitor. Tick 

‘Include marker’ to add a marking sign on the location. A marker will appear 

on your map. You can move this marker around to point the location you intend.  

Just click and drag the marker to the intended location.  

3. When done moving it to the right spot, you can copy the link on the link box 

and share that link as you like. 
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Picture 2.11. Sharing OpenStreetMap link 

 

2.7 Creating OpenStreetMap Account 
You have seen the layout and main menus of the OpenStreetMap website, now you 

can learn how to make an account in the OpenStreetMap and make your first 

contribution. Here is how: 

On the upper right corner of the OpenStreetMap website, click ‘Sign up’ 

1. You will see the following page: 

 
Picture 2.12. First Page When Creating an OpenStreetMap Account 

  

2. There are five columns you need to fill in to create an OSM account. 
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3. Insert your email address on the first two columns. You have to fill in the exact 

same addresses on the two boxes. This is where the confirmation email will be 

sent to. 

4. On the third box, fill in username that you want to use. If you wish to use your 

name as the username but somebody else has used it before, please note that 

you cannot use that same username anymore, so please find another username 

still available. 

5. Fill in the password that you want to use in the fourth and fifth boxes. You have 

to fill in the same password in both boxes and these passwords do not have to 

be the same with the one you use for your email account. 

6. Once done filling out these columns, click ‘Sign Up’ in the bottom part of the 

website. 

 

In this stage, you have registered yourself an account for the OpenStreetMap, but you 

have not activated this account. To activate, these are the steps: 

1. Open a new tab on your browser and open up your email. 

2. Type in your email address and your password.  

3. When succeeded, you will see an email from OpenStreetMap in your inbox.  

4. Open that email. Click the link in the email body, as shown in the picture 

below. 

 
Picture 2.13. Notification about OSM Account Registration Sent to Email 
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5. A new tab will automatically appear on your browser. If it runs as described, 

congratulations, now you have an OSM account! 

Notes: 

If a trouble occurs, a message will appear. Make sure the email addresses and passwords you 

typed in were the same. If the username column turns red, that means somebody else has 

taken that username and you need to use a different username. 

 
 

6. On the OpenStreetMap main page, click ‘Log in’ on the upper right corner. 

Insert your username and password and then press enter. You will be logged in 

and you can see your username on the upper right corner of the OpenStreetMap 

website. 

 

Congratulations! If you completed all the parts explained in this chapter, you would 

already have an OpenStreetMap account and know how to navigate the 

OpenStreetMap website. 
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Chapter 3 

Adding OpenStreetMap Data with 
iD 

 
Learning Objectives 

• To understand the concept of iD 

• To know how to use iD 

• To know iD’s interface 

• To understand and to practice how to change the map background 

• To understand and to practice how to operate iD 

• To understand and to practice how to modify objects using iD 

• To understand and to practice how to save new edits with iD 

• To understand the additional attributes available on iD 

• To save and to upload edits 

 

If you have succeeded making an OpenStreetMap account, you have the access to add 

new data to OpenStreetMap. Now we will learn how to add data on the 

OpenStreetMap website, using a tool, called iD. 

iD is an OpenStreetMap web-based editor that can be used to add and to change data 

on OpenStreetMap. iD has basic functions that enable users to update OpenStreetMap  

data easily and quickly using spatial data sources, such as satellite imagery, GPS, and 

Field Papers. Because iD is an OpenStreetMap web-based editor, using iD to add 

data, you need to connect to a stable internet connection. 

 

3.1 Starting the iD 
Before starting, your computer needs to connect to the internet. Open your internet 

browser, and type in OpenStreetMap website (http://www.openstreetmap.org). Login 
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to your OpenStreetMap account and zoom in to the area you would like to edit until the 

Edit tab becomes active. Click on the arrow sign next to Edit and then click Edit using 

iD (editor in the internet browser). 

 
Picture 3.1. Activating iD on the OpenStreetMap 

 

 

3.2 iD’s Interface 

Picture 3.2 iD’s Interface 
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1. Features Panel: This panel can display attributes of an object and show that object on the 

map. You can edit attributes of an object from this panel. 

2. Tools panel: This panel shows several basic functions to edit a map, including: 

 
To add a point 

 
To add a line 

 
To draw a polygon 

 

To undo 

 
To redo 

 
To save changes 

3. Map panel: this panel shows several function to customize map display, including: 

 
Zoom in 

 
Zoom out 

 
To go to the current location 

 
To set the map's background layer 

 
To open help menu 
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4. Information panel: this panel shows who have contributed editing the area.  

Picture 3.3. A History of Contributors Who Have Edited an Area 

 

 

3.3 Setting up Map Background  
Before starting to edit, you can of course change the map’s background. Please try 

clicking this icon    to open up the following panel: 

 
Feature 3.4. Background and Brightness Setting in iD  

There are several things you can do to change the background on iD, including these: 

• You can set the brightness level of the satellite imagery by clicking one of 

these boxes::    there are 3 brightness level 100%, 50%, and 0%. Try 

all of them to see the differences. 

• You can also set the type of satellite imagery by choosing from available 

providers (Bing Aerial Imagery is the default setting). You can also select 

OpenStreetMap as the background. 
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• If you would like to show uploaded Field Papers as background, please click 

on Custom and fill in the Field Paper url (for example: 

http://fieldpapers.org/snapshot.php?id=fdsbgzns#17/-6.20049/106.82533) on 

the pop-up window, as shown in the Picture below: 

 

 
Picture 3.5. Inserting Field Paper to the iD 

 

 • You can also add GPS tracks and waypoints from your computer (GPX 

format). You only need to click left on your GPX file, hold, and drag it into the editor 

page. 

• If there is a satellite imagery offset, you can correct it by clicking on Adjust 

Imagery Offset so the following box can appear:  

 
Picture 3.6. Adjust Imagery Offset Setting 

You can adjust the correction by clicking the navigation buttons

. Click on   to revert to its previous position. 
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3.4 Basic Editing with iD 
Before we start practicing with iD, so you could feel more at ease adding new data to 

the OpenStreetMap, please drag to an area that you are familiar with. You can change 

what is on display by click and hold on the left side of your mouse while dragging it to 

the location you desire. 

 

1. Adding Nodes 

Click on this button  , now you see that your cursor changes into this sign (+). 

Now, click on a place you know. For example, on the map you see a building that you 

know is a hospital. Click on that position. 

Picture 3.7. Adding nodes on iD 

You will see that you get a new node. At the same time, features panel will show options 

of attributes you can use to add to your first node, in accordance to what it is in real 

life. Click on Hospital Grounds, to add that the location is a hospital. 
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Picture 3.8 Adding a node feature on iD 

 

Your node symbol will change automatically, and your features panel change into a 

form to add more information about the objects you are referring to. You can add the 

name of the hospital, its complete address, and other additional information. 

 

Note: each feature has different forms to fill, depending on the type of features in use. 

 

If you made a mistake, you can drag the node you made by holding the left side of 

your mouse and drag it to the new location. If you want to delete that node, click once 

on the node you want to delete, until this sign appears  to delete an object. 

 

2. Adding Lines 

 

Click this icon  ,  and then you will see your cursor changes into this (+). If 

you want to draw a highway, click on one of the point of the road, and then move your 

mouse so it forms a line, click left on the mouse again to make a node (for a turn point, 

for example). Click twice to end the line. Take a look again at the panel to your left. 
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Picture 3.9. Adding a Line on iD 

 

Just like when you adding a node, after you draw a line, a feature panel will show 

selectable attributes that you can use to identify the line you drew. You can drag a node 

on the line by click and hold on a left side of your mouse and then drag it. You can also 

drag the line by a left click and hold and then drag the line. When you click a line, you 

will find additional functions, as follows: 
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To delete a line 

 

To change a line into a circle 

 

To move a line's position 

 

To reverse the line’s direction 

 

To straighten a line 

 
 

3. Adding Polygons 

To add an area on a map, click on this icon   . You will see your cursor changes 

into a plus sign (+). You can then draw a line following its shape on the map. For 

example, if you want to add a building on the map, you can draw that area following 

its shape on the map. What makes a line and an area different, you can see a color on 

the inside of an area, depending on its attribute. 
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Picture 3.10. Adding an Area / Polygon on iD 

 

 

 

To delete a line 

 

To turn an area into a circle 

 

To move an area's position 

 

To make an area’s corners in square 

 

To rotate an area 
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Similar to nodes and lines, when you click on a node in that area, you will additional 

functions. This also applies when you click on a line in that shape.  

 

3.5 Saving Your Edits 

Click the button to save your edits. You will see the panel on your left 

will change into something similar to the following: 

 
Picture 3.11. Saving Edits on iD 

 

Fill out the change set comment with what kind of edits you have made on the objects 

so other users can find out. When done, click ‘Upload’. 

 

3.6 Additional Attributes 
When you determine an attribute, you can also add additional information by clicking 

the following options:  
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Elevation To add information on its elevation 

Fix Me To explain that this building needs fixing 

Level To add the number of stores/level on that building 

Note To add notes 

Telephone To add contact/telephone number 

Sources To add sources 

Website To add website information 

Wheelchair 
access 

To add information on the building’s accessibility to a wheelchair 
users 

Wikipedia To add a link to a Wiki article 

 

 

Picture 3.12. Additional Attributes on the Features Panel 
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Besides, you can your own attributes by clicking ‘All tags’. Click on the + sign to add 

key and value that you would like to add. A complete list of key and value can be seen 

in this list: http://wiki.openstreetmap.org/wiki/id:Map_Features 

 
Picture 3.13. Filling in one of the tags on iD 

 

 

SUMMARY 

Now that you can add data on OpenStreetMap using an editor, called iD. You have also 

known different objects on OpenStreetMap, including nodes, lines, and polygon. iD 

helps you add new information on the OpenStreetMap without you having to install 

additional software. Using iD, however, you have to keep being connected to the 

internet, which means when your connection gets unstable, you will encounter some 

difficulties. Another alternative is by using another tool to add data on OpenStreetMap, 

which is JOSM. 
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Chapter 4 

Adding Data to OSM Using JOSM 

 
Learning Objectives: 

• To understand the definition and the concept of JOSM 

• To understand how to download JOSM installation files  

• To practice how to install JOSM 

• To operate the basic settings on JOSM 

• To understand JOSM interface 

 

We will now learn about steps to download and to install JOSM. JOSM stands for Java 

OpenStreetMap, which is a desktop base OSM editor. We need to always be 

connected to the internet when using the iD, but with JOSM we can do edits even 

when the computer is offline or is disconnected from the internet. This will help 

people working with limited internet connection. Users only require internet 

connection when downloading or uploading data from and to OpenStreetMap. 

In this chapter, we will modify several settings in the JOSM so we can use the tool 

well. Besides, we will also learn about the features available on JOSM’s interface. By 

understanding each part of JOSM, by the end of this chapter we will be able to 

understand JOSM in its entirety alongside with some of its basic settings. 

 

4.1 Download JOSM 
If you have a copy of JOSM installation software in a CD or flash drive, you can go 

directly to the subchapter, JOSM Installation. But if you do not have JOSM 

installation package or that you wish to update the version, you can open your web 

browser — such as Firefox, Chrome, Opera or Internet Explorer. On the address bar at 

the upper side of the browser, type: josm.openstreetmap.de and then press enter. You 
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can also find this website by searching ‘JOSM’ at a search engine. JOSM website will 

look like this:

 

Picture 4.1. JOSM Interface 

  

Please select an installation file that matches your computer’s operation system. If 

you use a computer with Windows operation system, click “Windows JOSM 

Installer” to download JOSM. If you have a different operating system, click on the 

link that matches your computer’s operation system. You can then download the file. 

In this tutorial, we will explain from Windows OS, but the steps are similar to other 

operating systems. 

 

4.2 JOSM Installation 
When you are done downloading JOSM installer, you can install JOSM into your 

computer or laptop. The following is how to install JOSM: 

1. Find the JOSM installation file in your computer. Click twice on that file to start 

setting. 

2. Click ‘OK’, ‘Next’, ‘I Agree’, and ‘Install’. When it is done, click ‘Finish’ to 

open JOSM for the first time. In the next turn, you can open JOSM again by 
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clicking the start menu on the bottom left corner of your monitor, and then find 

and open JOSM by clicking on its shortcut on the menu. 

3. When JOSM is open, here is how it will look like: 

Picture 4.2 JOSM Opening Interface 

 

Notes: 

1.        You may encounter problem installing JOSM if you do not have Java installed on your computer. If so, you can 

download and install java from here: http://www.java.com/en/download/ 

2.        You may also see a pop-up window when opening JOSM for the first time, asking you update the software. You do 

not need to do this as you have just recently downloaded the software. Click ‘Cancel’. Tick the box at the bottom part of it 

before clicking Cancel if you do not wish to see that notification again. 

3.        The JOSM used in this tutorial is version 11427. The layout displayed in this tutorial may change if you use the older 

version of JOSM. 

 
 

4.3 JOSM Settings 
4.3.1 Language Setting 

There are a lot of settings you can do with JOSM. One of them is language setting. 

JOSM has been translated into many languages, and you can select the language you 

want to use. 

1. To access the preferences window, click Edit -> Preference. 

 
Picture 4.3. The Icon to Show Preferences Menu on JOSM 
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2. On the left side, click on the icon with a paint can and brush. 

3. Above the window, click the tab ‘Look and Feel’. 

4. Select the language of your preference on the drop down list ‘Language’. 

Click OK and restart JOSM to change it into Bahasa Indonesia. 

Picture 4.4. Changing Language in JOSM 

 

  

4.3.2 Account Setting and Network Proxy 

After changing the language you use in JOSM, you need to insert your username and 

password. This is so the server could recognize the edits and data addition that you 

make belong to you. If you do not put in your username, you will not be able to 

upload your data into OSM. Here is how you can do it: 

1. Open preferences tab, and then click on the icon with the Globe symbol located 

on the left side of preferences box 

 

2. Select “Use Basic Authentication” 

3. Fill in your OSM username and its password. 
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Picture 4.5. Fill in OSM username and password into JOSM 

 

4. If your internet connection uses a proxy, you can also fill in the proxy in the 

proxy setting tab to adjust to your internet proxy. 

   

4.3.3 Adding Presets 

Now that you have typed in your username, you can set the presets in JOSM. What are 

presets? Presets are files that give information related to objects being mapped to the 

OpenStreetMap. Do not worry if this definition is yet to make sense to you as we will 

learn further about them as we go deeper in this guide book. You can try add these 

presets with the following steps: 

1. Click the icon with the following picture: 

 

2. Click on the tab “Tagging Presets”. 

3. On the “Available Presets”, search and select the preset “Buildings Indonesia.”  And 

then click on the blue arrow on the right side of the box. 
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Picture 4.6. Adding presets files into JOSM 

  

Or if you already have your own preset files on your computer, you can add them directly by: 

● Click on the ‘+’ located on the right side of the di active presets box 

● And then click on the icon as shown below to look for your preset files:  

 

● Once found, click ‘Open’ and then ‘Ok’ 

  

4.3.4 Adding Plugin 

Now we will try adding plugins on JOSM. Plugins are extension tools to JOSM that 

can make edits easier. This is how we can add plugins into JOSM: 

● Click on the icon for plugin as shown below: 

 

● Click on ‘Download list’ to download all plugins available for JOSM 

● In the search bar, click on the plugins you want, such as ‘buildings_tools’ 

● Tick on the box preceding the text: 
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Picture 4.7. Downloading plugins into JOSM 

   

4.3.5 Activating Remote Control 

Remote Control settings in JOSM is needed so we can fetch OSM that we would like 

to edit from the internet, such as from openstreetmap.org, into JOSM. Here is how to 

activate: 

● Click on the following icon: 

● Tick on the box ‘allowing remote control use’  

● Tick on the boxes listed underneath as you need. 
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Picture 4.8. Activating Remote Control in JOSM 

  

4.3.6 Inserting Satellite Imagery 

We would need to insert satellite imagery as a background when we do edits, so that 

we will need to insert them from this setting window: 

1. Click the icon with WMS TMS on it, just as shown below: 

 

2. Click on “Bing aerial imagery”. And then click “Activate”. 

3. Click “OK” on the bottom part of the preferences window. 
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Picture 4.9. List of Satellite Imagery Layer on JOSM 

 

4.3.7 Setting the Objects Layout 

In the initial setting of JOSM, each object on OpenStreetMap do not show nodes, 

labels, and icons. 

 
Picture 4.10. Example of Opening Interface of JOSM 

In order to make them visible, you will need to change the map styling on your 

JOSM:  

1. Click on the menu File - New Layer to show JOSM interface 
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2. On the right panel of JOSM window, look at the Map Paint Styles 

3. Click right on JOSM default (Map CSS) and select Style Settings 

4. Adjust it as shown in the picture below: 

 
Picture 4.11. Map Paint Styles Setting on JOSM 

If you have altered all settings as shown above, your JOSM display will show nodes, 

labels, and icons for each OpenStreetMap objects. 

4.4 JOSM Interface 
Now that you have done a few settings on JOSM, to make your edits easier you will 

need to get acquainted with some of the most important parts in JOSM interface. To see 

JOSM interface, click on menu File - New Layer. The following shows some of the 

parts of JOSM interface. 

 

Picture 4.12. Parts of JOSM interface 
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On the main window that you are already familiar with—this is the map window and it 

is where most of the activities will take place. This window is where you will see, edit, 

and add data to OpenStreetMap. 

On the right side of the window, you will several panels, each has its own function. 

Usually, when you first install JOSM, you will see panels for standard setting, such as 

layers, tags/memberships, options, and makers. Layers panel will show what layers are 

added into JOSM, such as satellite imagery, et cetera. When you select a node, line, or 

polygon, it will be shown on the option panel. Information about objects are shown on 

tags / memberships panel, and the ones making the objects will be shown on makers 

panel. 

These panels can be made open and close by clicking several buttons on the bottom left 

side of JOSM. These are tools window with several buttons to edit, such as Object 

Selection Tool and Object Drawing Tool. Below are tools to make it easier to zoom in, 

delete an object, drawing a polygon, or to make a line in a parallel position to other 

lines. 

Picture 4.13. The Button to Set Panel Window on JOSM 

 

 SUMMARY 

If you are able to follow and to practice all steps in this chapter, you have been able to 

install JOSM into your laptop or your computer. Besides, you have also been able to 

learn and to practice how to do initial setting in JOSM to make your work easier. 

Later, you will learn about how to add data into JOSM, from beginner and advanced 

level. 
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Chapter 5 

Drawing Exercise with JOSM 
 

Learning Objectives 

● To practice how to draw with JOSM 

● To practice and to change paper maps into digital maps with JOSM 

● To practice how to draw with more advanced skills with JOSM 

● To understand editing tips on JOSM 

● To practice how to draw special objects 

 

 

5.1 Basic Drawing Exercise with 
JOSM 
Now please open the OSM sample file that we can use to learn how to draw maps with 

basic skills in JOSM. Please note that this data is only a sample file that does not 

correspond to any place in reality, so we should not be uploading them into 

OpenStreetMap. 

1. Download the file here: bit.ly/osmsample 

2. Open OSM map sample file in JOSM. Click “Open”  

on the upper left side.   

3. Find sample.osm file in your computer and then open it. Your computer will 

show something like this: 
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Picture 5.1. Exercise File in JOSM 

 

5.1.1 Basic Operations 

To move the map to right or to the left, up or down, click left on your mouse and hold 

and drag it. There are several ways to zoom a map in and out. If you use a mouse, 

you can scroll the wheel to for zooming it in and out. If you use a laptop without a 

mouse, you can use the scale located at the left of your map. Hold and drag it left and 

right. 

 

Picture 5.2. Zooming Scale in JOSM 

 

Look at the sample data. There are several different objects there. There are river, forest, 

some buildings, roads and a pair of shopping venues. To select an object, click on those 

objects. 

 

5.1.2 Changing Map Paint Styles on JOSM 

To make it easier to interpret and to draw objects in JOSM, you must first set the paint 

style on each object shown in JOSM. Here is how: 

1. Click Window from the menu, and select “Map Paint Styles” 

2. On the right panel, you will find Map Paint Style Panel, right click on “JOSM 

Default (MapCSS)”, and select “Style Settings” 

3. Untick all boxes other than “Areas are drawn with fill only around their 

inner edges”. 
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Picture 5.3. Map Paint Styles Setting 

 

 

5.1.3 Nodes, Lines, and Polygons 

There are three objects on OpenStreetMap. These three objects are nodes, lines and 

polygons. 

1. Nodes are locations shown by symbols. In the sample data you use, there are two 

nodes, which are a clothing shop and a market. A clothing shop is symbolized by a 

shirt and a market is symbolized by a shopping cart. 

2. There are several lines on the sample file. Lines represent a simple road network. If 

you look closely, a line consists of several nodes. These nodes do not have symbols 

or other information but these nodes form the line. 

3. Lastly, there are polygons/area in the exercise file that represent different places, 

such as forest, river, and buildings. A polygon in general represent an area or a 

building. Polygons are similar to lines but polygons have consist of several lines 

where the last node meets the first node of that line. 

 
 

 

 

 

 

 

 

Notes: 

It is very easy to think of maps consisting of three basic objects—points, lines, and polygons. In 

OpenStreetMap, there are other terms to use as you advance. In OSM, points refer to nodes, lines are 

referred as ways. Polygons are called closed way because essentially it is a line with the same nodes in its 

beginning and end. 



 

50 

 

5.1.4 Choosing Objects 

On the left side of JOSM, there are multiple buttons. To select an object in JOSM, you 

can select Button to Choose Object . Try choosing one of the area/polygon on 

your sample file. All objects that you choose will turn red, and on the right side, a 

panel will appear, showing “Properties”. In this properties window, it will show data 

attributes of object, referred to as tags. Tags are information on objects, including 

nodes, lines, and polygons that explain the identity of the selected object. From 

here you can figure out the information of a given object, whether it is forest, river, or 

buildings, et cetera.  

Picture 5.4. Object Information on Properties Window on JOSM 

 

 

5.1.5 How to Change Objects 

● Choose the forest on the left side of your map. Make sure you click on the line, 

instead of the nodes. Now click and drag the object. You can move the forest into 

a new location on the map.  

● Click one of a node around the forest. You can move that node. By doing so, you 

change the shape of the object. 
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5.1.6 Drawing Objects 

There are a lot of symbols on the left side of JOSM that provides information about the 

map. The most important button is located at the upper part of the column. These 

buttons change what you can do with your mouse. 

 

Button Name of the Button Description 

 
 

 

Select, move, scale 
and rotate objects 

This button can be used to select objects. By choosing 

an object, you can drag, change shapes, rotate, and even 

delete an object.  

  
 
 
 

   

Draw nodes This button is used to draw objects: 
● To create nodes, click twice on the map. 
● To draw lines, click once with your mouse, 

move it to the point you intend to and then click 
once again. You can do it again to draw longer 
lines and then click twice to end it. 

● To draw a polygon/area, you can do it using 
the same method of drawing a line, except that 
to end the process, you need to click twice on 
your first node where you started your drawing. 

 
 

5.1.7 How to Add Presets 

At this section, we have already learned how to draw nodes, lines, and polygons, but 

we have not covered how to add information on these objects. We would need to 

know whether the area we draw is a school, a shop, et cetera, or whether it is a 

building at all or something else. To add information on an object we drew, we need 

to add presets on that object. Here is how: 

● Click Select  , on the button at the left panel. 

● Choose one of the objects that you will make with Draw button. On the upper 

menu, click “Presets”. Hover your mouse to the submenu you would like to add. 
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● Go to Preset menu. Click on the item with “Building”, that has now been added 

to the bottom part of the menu. 

 

   Picture 5.5. Building Presets at JOSM 

● When you click on the preset, some columns will appear and ask you about more 

information on the object. You do not have to fill in all columns, such as the name 

of the object you created. 

● When you have finished inputting information, click on “Add Preset”. If 

everything goes well, the nodes, ways, and polygons that you created will change 

color and will have certain symbol. This depends on the information you added 

into those objects. 

 

5.2 Advanced Drawing Exercises with 
JOSM 
In the previous session, you have installed JOSM and learned about some basic 

operations, such as how to draw nodes, ways, and polygons. You have also learned how 

to add presets into the object you created by attaching information about those objects.  

 

In this section, we will take a closer look at the JOSM interface and learn about several 

steps to take in order to edit OpenStreetMap in JOSM and how we can maximize tools 

available in JOSM that can help us making edits in easier manner.  

 

5.2.1 Advanced Drawing Tools on JOSM 

In this section, we will inspect several basic tools available and some techniques to 

draw map features in JOSM, in the preceding chapter we will learn more about more 

advanced drawing technique. If you would like to follow and to practice some JOSM 
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editing tools, please download from bit.ly/edittools and then open JOSM and the file 

you downloaded. It will look like the following: 

 
Picture 5.6. Exercise File to Edit Using JOSM 

 

JOSM has several additional tools to make it easier to draw ways and polygons. These 

tools can be found in the “Tools” menu at the upper part of JOSM. When you click on 

this menu, you will see there are a lot of functions available to help you with drawing 

lines and polygons, and to edit objects on you map. 

 
Picture 5.7. Options Available on JOSM Tools Menu 
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In order to apply a function from this menu, you would have to first choose a node, a 

way, or a polygon from your map window. The sample file you downloaded has a 

variety of elements with labels on different tools from the menu. 

● Select one of the element in that file. Go to Tools menu and click on the functions 

indicated on the side of the feature you selected. 

● For example, click on the irregularly shaped to choose it. 

 

● Go to Tools —> Align Nodes in Circle 

● That circle will change into being more symmetrical. 

 

Try each of the feature available on the sample file. The following is the description of 

several tools available: 

● Split Way:  this allows you to split one single way into two separate ways. This 

is useful when you want to add attributes to a different section of a road, such as 

bridge. To use this function, click on a node from the way you want to split, and 

then click Split Way from the Tools menu; the way should have parted into two. 

● Combine Way: this is the reversal of Split Way. In order to combine two ways 

into one, they have to share one node. To use this function, chose both ways you 

want to combine. You can do this by pressing SHIFT on your keyboard while 

clicking on the ways. When you have selected the two ways, click Combine Way 

from Tools menu. 
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Feature 5.8. The Output of Combining Ways in JOSM 

 

 

If you combine two ways that have different directions, you will get this warning: 

Picture 5.9. A Conflict Appearing When Combining Two Ways  

If you are sure about combining the two ways into one directional way, choose 

“Reverse and Combine”. 

 

● Reverse Way: this will reverse the direction in the selected way. All ways in 

OSM have its directions, which is shown on OSM by arrows on the lines. These 

directions are usually not a problem, except for roads that have one direction or for 

rivers that flows in one particular direction. There are cases when you may need to 

reverse the direction of the ways so it reflects the object (such as the rivers) more 

accurately.  

 
 

● Simplify Way: if your drawn way has too many nodes in it, you may want to 

simplify it, this will delete some nodes on the selected line. 
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Picture 5.10. Sample Line that Needs Simplifying on JOSM 

 

● Align Nodes in Circle: when you try to draw a circle, you can try make the shape 

as close to the circle shape as possible and then select the object. This function will 

help align the nodes to form a circle.  

● Create Circle: as an alternative, you can try this tool. Draw a line that will become 

a diameter of your circle which consist of two nodes, and then apply this tool. 

.  

 

● Align Nodes in Line: this function will align nodes into a straight line. Try this, 

preferably with a long line to see how the line is straightened out. Look out for the 

position of this line, however, as it usually drags the line off its intended position. 

 

 

Picture 5.11. A Sample of Straightening a Line 

 

● Orthogonalize Shape: this function is very useful to draw clear-cut shapes, such 

as buildings. After you drew an area, this function will help shape the corners into 

squares. 
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Picture 5.12. A Sample of Making a Polygon Become a Perfect Square. 

 

● Unglue way: this tool allows you to detach otherwise connected nodes. This is 

useful when two objects share nodes that shouldn’t be as such in real life. As an 

example, there are common mistakes in mapping where a road share node with a 

building’s body. Of course, such case cannot be true, whereas a building is attached 

to a road network. You can detach these objects from one another using this tool. 

 

Picture 5.13. Ungluing Ways and Nodes 

 

• Rotate Objects: you may wonder how to rotate a line or a polygon when they 

are already drawn. 

1. To rotate an object, you have to first select the object. 

2. Hold SHIFT+CTRL on your keyboard. 

3. Click and move your mouse to rotate the object. 

 

 
Picture 5.14. Rotating Objects in JOSM 

 

 

5.2.2 Shortcuts on Keyboard 

After doing some edits in OpenStreetMap, you may realize that you need considerable 

time clicking on menu and submenu. To overcome this, JOSM has shortcuts for many 

functions. This is to save time when performing a task, so users do not need to search 
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for the function from the menu and submenu; they can instead use their keyboards to 

perform the same task. The following are some of the most important shortcuts. 

1. To Activate Select Tool 
 

4. To Delete Selected Object 

 

 

2. To Activate Draw Tool 
 

5. To Zoom In 
 

3. To Activate Zoom Tool 

 

 

6. To Zoom Out 

 

 

 

 Some Shortcuts on JOSM 

 
5.2.3 Plugins on JOSM 

When you are used to making edits on your map. you may want to set additional JOSM 

features to enhance your mapping abilities. JOSM allows you to install add-ons, and 

inserting additional functions to the software. In this section, we will look at some of 

the very useful plugins already available for JOSM. 

● buildings_tools: when you want to draw a lot of buildings, this function will make 

the process quicker and easier. Building Tools Plugin facilitates digitizing 

buildings as it allows you to draw a square shape with various length. When you 

draw buildings, this plugin shortens the amount of clicks and time needed. After 

you install the plugin, a new button—as shown below—will appear on the left side 

of JOSM: 

   

 

How to use: 

● Start JOSM with new, empty layer. 

● Select Building Tool and click to draw a line on the map. 
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● Move your mouse and click once again to draw a square. 

● This will not only make a square block by only three clicks, but it will also 

automatically add building=yes tag into the polygon. 

 

 
Picture 5.15. Drawing Buildings with Building Tools 

 

You can also draw more complex buildings by firstly draw overlapping buildings 

and then merge them into one. 

1. Draw two overlapping buildings, so it has an L shape. 

2. Select both buildings (press SHIFT to select more than one object). 

3. Go to Tools -> Merge Overlapping Areas or press SHIFT+J on your keyboard. 

 

Picture 5.16. How to Draw L-shape Buildings? 

 

● DirectUpload: if you collect a lot of GPS tracks and you want to save it into 

OSM database, this plugin will make it easier for you. 

● Editgpx: if you want to upload GPS tracks from a Garmin device, you may need 

to use this plugin. OSM will not accept GPS tracks already saved in Garmin’s 

external memory, but this plugin will correct the formatting so it can be uploaded. 

● Fieldpapers: this plugin can load scanned Field Papers into JOSM. 

● imagery_offset_db: this plugin works with imagery providers that detect Bing 

imagery offset. This problem will be discussed in a later part. 
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● mirrored_download: this plugin allows you download larger OSM area for 

edits. 

● Print: this will add print function, if you need to print an area quickly with lower 

quality. 

● Utilsplugin2: to add many additional tools and menu on JOSM. 

If you have not installed this plugin, here is how to do it. 

 
Picture 5.17. Display of utilsplugin 2 

 

After you have installed this plugin and restarted JOSM, you will have new menu, 

under “More tools” menu. 

 
Picture 5.18. Menu for Additional Tools at JOSM 

 

Create a new layer and we will experiment with some of these new tools. We will 

learn how these tools are very useful. 

 

1. Add Nodes at Intersections: this tool is very useful to add missing nodes at 

selected intersections. Please be mindful that two crossing intersections should 

have a node where they intersect. 

 
Picture 5.19. Adding Nodes at Intersections 
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2. Copy Tags from Previous Selection: this function enables easier copying for 

tagging. If you want to create objects with the same tagging, first draw an object 

and then add tagging to this object. Click on other objects and press Shift + R to 

copy the tags from the previous object. You can do the same steps for all objects 

that have the same tagging. Please remember that the tags are copied from a 

previously selected object, if you click on an object with no tags prior to 

performing the task, the tagging will not be copied. 

 
Picture 5.20. Copying Tags from Selected Buildings 

 

3. Add Source Tag: this tool simplifies adding source tag. It will remember your last 

source tag and add it to your object. You can add source tag just by one click. 

 

Utilsplugin2 also adds more tools under “Selection”. You can try experiment with 

these tools. 

 

Picture 5.21. Menu from Selection 
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One of the selection tools we will often use is Unselect Nodes: this tool cancel selection 

of all nodes. This is useful when you hover an area to select multiple objects, but do not 

want to include all objects—nodes, ways or polygons—in that area.  

 

 
Picture 5.22. Unselecting Nodes on JOSM 

 

5.3. Editing Tips 
There are several common mistakes for beginner when contributing to OpenStreetMap. 

The following are among the most common ones, alongside with how to avoid and to 

resolve these mistakes.  

5.3.1 Objects that Should Not Intersect 

When you make polygons or ways that should not be connected to each other, make 

sure they do not share nodes. For example, buildings should not share a node with road 

network, because there is no road directly attached to a building. If you want to separate 

the two objects, select the intersecting node and then choose Tools ->  Disconnect Node 

from Way or press G.  

 
Picture 5.23. Objects that Should Not Intersect 
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5.3.2 Objects that Should Intersect 

Two ways that intersect should be connected with a node. Otherwise, the computer will 

not detect these two as intersecting to one another. When you see two intersecting ways 

do not share a node, you can correct this by adding a node, by going to Tools -> Merge 

Nodes or press M and try moving it around. 

 
Picture 5.24. Roads have to Connect to One Another 

 

5.3.3 Overlapping Objects 

Another common mistake is overlapping objects for objects that should not overlap in 

real life. A building cannot overlap with other buildings. For example, a polygon for 

outdoor park should not intersect with a building, it should be drawn next to it instead.  

 

 
Picture 5.25. Sample of Buildings that Overlap between One Another 

 

There are some exceptions to this rule, such as school. Within the school court, you 

may want to identify the buildings with polygons, but you may want to add a polygon 
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that includes all school’s court area. In this case, polygons may overlap, but make 

sure that all buildings are all fitting in inside the land area. 

 
Picture 5.26. Sample of Buildings that Correctly and Incorrectly Overlaps 

 

5.3.4 Other Errors 

The following are some of the other common mistakes often found committed by new 

OpenStreetMap users. 

Tag is given to a node, not to a building 

 

Samples of a building with false tagging (left) and correct 

tagging (right) 

One of the common mistakes 

is to add a tag on a node, 

which is only a part of a 

polygon’s way. This happens 

when someone draw a 

building and select a node on 

that object. When you are 

tagging, you have to select 

the whole object (select all), 

which include all ways and 

nodes. When you are adding 

a tag only to a node, it is not 

a correct tagging. To avoid 

doing this, click on the way 

before adding tags. 
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A turn that meets in an intersection / a turn that has to be 

made separate 

 

 

 

A wrong way of drawing intersection (up) and the correct 

one (bottom) 

When two ways intersect one 

another, you should not draw 

a bending way in that 

intersection. The intersection 

has to be in 90° degree, as 

how it will look like in 

reality. 

No tag on a node or line 

 

To correct this, select the 

object and insert presets that 

match the information for 

that object. You can also 

delete those objects if they 

are mistakenly drawn. 
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A way is drawn nearby other way but are not connected 

 

A sample of two disconnected way 

To correct this, you can select 

a node from a way you want 

to connect and then choose 

“Draw Node” to add a node 

on the way in front of the 

selected node. You can also 

use “Merge Nodes” (if the 

ones in front of the way is a 

node), the way to do this is:  

1. select both adjacent nodes 

on the two ways you want 

to connect 

2. choose “Merge Nodes” 

from the Tools Menu. 

If there is no node in front of 

the way you wish to connect, 

you can use “Join Node to 

Way”, by: 

1. Choose the last node from 

the way that you have not 

merged and also select the 

way in front of it. 

2. Select “Join Node to 

Way” from the Tools 

menu. 



 

67 

A way cannot bypass a building 

 

A sample where a way bypass a building 

To resolve this, you have to 

inspect the satellite imagery, 

which object is mistakenly 

drawn. When you are sure 

about it, you just need to 

move the object to the correct 

position.  

 

5.4 Drawing Special Objects 
Up to this point, you have learned how to draw objects on OSM using JOSM and some 

of the common subjects you need to pay attention to when drawing objects with JOSM. 

When you try drawing objects on top of a satellite imagery, you may find some 

buildings that need special drawing skills, such as bridges, office complex, or big roads 

with barriers to it. 

5.4.1 Drawing Bridges 

A bridge is commonly found on top of a waterway. On the OSM, however, you cannot 

just draw a road on top of a river. When you do that, technically, you can still upload it 

to OSM, but the system will recognize it as an error. So how do we draw bridges 

correctly? 

Here is an area with a bridge object within: 
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Here is how we can digitize it: 

1. First, draw the waterway 

 

2. Draw the road network that passes (above) the waterway 

 

3. Zoom the imagery in, you will be able to see the left and right side of the bridge. 
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4. On the road network, make nodes on top of the left and right side of the bridge 

 

5. We will then split the ways for bridge and road network. To split ways, you can do 

the following: 

1. Click on the recently made nodes, which represent the left and right side of the 

bridge. To choose more than one node, press Ctlr. Select Tools —> Split Way. 

 

2. The way that is initially in one way is now divided into three, which are (i) the 

way to the left of the bridge, (ii) the bridge, (iii) the way to the right of the 

bridge. 

 

6. After having the bridge drawn as a lone-standing object, the next step is to give 

tagging / information that the object is a bridge. Now click on the bridge object, 

and click on the menu “Preset” →  “Man Made” →  “Bridges” →  “Bridge” 
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A dialogue box for bridges will appear. You only need to fill it out with this 

information “Bridge” = ‘yes’ and “Layer” = ‘1’ 

 

7. Done. 
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5.4.2 Drawing School/Office/Building Complex 

A school, hospital, or office buildings in general do not stand as a single building, but 

instead, consists of several separate buildings within the area. Look at the following 

example:  

Some people draw it as a big complex with fences surrounding it (see picture a). The 

others draw each building within the complex separately, and then each building are 

tagged with the name / information of the school (picture b). Doing that, the system 

will count the school as more than one and that is not the correct way of drawing it. 

  
Picture (a)                                            Picture (b) 

So how do we draw a building complex correctly, with a lot of smaller buildings within? 

Relation is the answer! The following is the steps. 
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1. Firstly, draw the elements / parts of the schools, such as classrooms, parking lot, 

mosques, playing court, and parks. Give tagging according to the objects. Do not 

tag with school or hospital yet.  

 

2. After each part is drawn, draw the fence or the outer part of the school, and then 

add the tag “amenity = school”. 

 

3. It is time to make school relations! Here is how: select all of the school, to select 

more than one object, press and hold Ctrl on your keyboard. After all elements 

are selected, also select the outer part of the school. 
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And then choose “Tools” > “Create Multipolygon”. Your object will look like 

this. 

 
 

If you click on / select the outer part of the polygon, which is the school fence, 

the area within the polygon will become purple, and an additional panel, which 

is the “member of” panel. 
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If you now click on the button “edit” from “member of” panel, the following 

dialogue box will appear. This dialogue box will show that polygon we selected 

is the outer part of a school complex. In relation terminology, such type of 

polygon located at the side most part is called outer; while all other polygons 

within (schools/classrooms, mosque, parks, courts, parking lot) are called inner. 

 
If you click on one of the objects / buildings within, there would only be object 

information, without the school name; and there will be a “member of”  panel 

that indicate that the object is an inner part within a relation SMA Negeri 1 

Ngawen. 
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5.4.3 Drawing Road Network with Middle / Dividing Lines 

A road network can be found in a simple form (1-3 meters width and without dividing 

lines in the middle) (picture a), but you can also find it in a more complex form, a very 

wide one (up to 10-20 meter) with middle lines (picture b). 

  
 Picture (a)                      Picture (b) 

To draw a simple road network is of course very easy, you can do it by just drawing one 

way. But to draw a road network with a dividing line in the middle, you need to draw 

the roads separated into two opposing directions.  
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The following is part of Thamrin Highway, Centre of Jakarta. This highway is about 40 

meters wide, with a dividing line in the middle that separates the roads to the north and 

to the south.             

 

To draw Thamrin Highway, we need to draw two ways, that represent the side roads for 

vehicles heading to the north and to the south. 

Firstly, draw a line from the bottom to the top (north to south), and then give a tag from 

the Presets menu → Highways → Streets → Primary and then add relevant 

information, such as the name of the highway, Jalan Thamrin. And then activate the 

option “One Way” located on the presets for highway. Afterwards draw a line from the 

top to bottom (south to north) and then give the same tag “highway=primary”,  

“name=Jalan Thamrin” and “oneway = yes”. 
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Make sure that the arrows on both ways are pointing to opposing directions. On the first 

way, it should point upwards, which means this area is for vehicle from the south 

direction, while the second way points downwards which means it is for vehicles from 

the north direction.  

If a road has four different lanes (which means it has three middle lines), such as slow 

lane to the north, speed lane to the north, slow lane to the south, and speed lane to south; 

we need to draw it with four ways. Such condition can be found in Sudirman Highway.  

A part of Sudirman Highway, 

Centre Jakarta, with four lanes 

(3 middle lines). 
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How the highway look like 

from the satellite imagery 

above. 

These lanes, although belong to 

the same highway, which is 

Sudirman Highway, consist of 

four lanes on OSM, and should 

be drawn as four separate ways. 

5.4.4 DRAWING MULTILEVEL BUILDING 

A skyscraper, when photographed from the above by aerial imagery or sattelite imagery, 

will generally look tilted.  The following are pictures of one of the skyscrapers (Picture 

a), from a satellite imagery, the building look like it is leaning to the side (Picture b), 

due to the photography or satellite imagery’s angle when capturing the picture. 

   
Picture (a)                                                                  Picture (b) 

Some people may draw these object incorrectly. Picture (c) and (d) show some 

examples of incorrect drawings. On picture (c), the building is drawn based on tis roof’s 
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position, when it should have been drawn based on the building’s foundation. 

Meanwhile picture (d), the building is drawn in its entirety from its body to the roof.  

With such drawing, the building will have an irregular shape, when the real building 

has a square form. 

  
Picture (c)                                                                  Picture (d) 

So how do we draw skyscrapers or multilevel buildings correctly? 

○ First draw the building’s roof (assuming that the foundation has the same shape with 

the roof). 

 
 

○ Give tags according to the type and information of the objects 
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○ Drag building’s roof to where the foundation is. 

 
 

○ Done! 

 

 

SUMMARY 

If you follow all instructions, you would have been able to do basic settings for JOSM 

in your computer. You have also recognized the tools to draw in JOSM. In the next 

chapter, you will also learn further how to do OSM edits with JOSM.  
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Chapter 6 

Adding OpenStreetmap Data with  
JOSM 

 

Learning Objectives 

● To understand steps to add data to OSM 

● To practice how to download OSM data 

● To practice how to add satellite imagery to JOSM 

● To practice how to add and to edit OSM data using JOSM 

● To practice how to upload edits to OSM 

● To understand how to save file in OSM 

● To know how to see data change set in OSM 

 

6.1 What Are the Steps to Add OSM 
Data from JOSM? 
To add OpenStreetMap data with JOSM is similar to using iD Editor, but because JOSM 

is a desktop application, there are several differences. The following is the editing 

process and how to add to OpenStreetMap using JOSM, you only need to follow these 

steps: 

● Download map data that you want to edit directly from the OSM 

● Insert satellite imagery, GPS or Field Papers 

● Edit using satellite imagery, GPS or Field Papers 

● Upload changes into OpenStreetMap 
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Picture 6.1. Steps to Add Data to OSM 

 

6.1.1 Download Data OSM 

The first step to add or to do edits is to download existing data from the area we want 

to add to change from. Remember that you can do it anything you would like to this 

maps will also be updated many times by other users. 

● Click “File” on the upper left corner of JOSM and click “Download from OSM”. 

A download window will open, you can also access this window by clicking on 

the download button, as follows: 

 

● When the download box pops open, you will see a map with a pink square in it. 
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Picture 6.2. Download Window to Download Imagery 

 

● The pink square is the mapping area you will download. Use your mouse to move 

or to zoom in the area you want to edit, such as your house or your neighborhood. 

Right click and hold to drag the map and use the scroll wheel to zoom the map 

in and out. 

● Draw the square in the area you wish to download. To draw new square, click 

and hold on the map and move the mouse to areas you want to cover. Release the 

mouse click to when done. 

● When your square covers the right size and position you want to edit, click 

“Download” in the bottom part of the window. JOSM will download 

OpenStreetMap data from this area and open it in a map window for you to edit. 
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Picture 6.3. The Interface when Data is Downloaded from OSM Server 

 
 

6.1.2 Adding Satellite Imagery 

If you still remember how to edit using iD editor, you can see that underneath the map 

data there is a satellite imagery to help you identify the objects from the earth’s surface. 

This imagery is from Microsoft Bing, which provides the satellite imagery for 

OpenStreetMap users for free as a reference to contribute to mapping. To add Bing 

satellite imagery into JOSM, click on “Imagery” on the upper side of JOSM and select 

“Bing aerial imagery”. 
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Picture 6.4. Bing Sattelite Imagery has been added into JOSM 

 
6.1.3 Editing with JOSM 

We have done several mapping steps in JOSM which are by downloading OSM data 

and we have prepared JOSM with a satellite imagery as a reference. The next step is to 

edit the map and to add new objects. 

You may get a lot of or a few spatial data in JOSM, depending on the size of the area 

you use. Remember this is the same type of data we use and learn about in the previous 

steps—nodes, ways, and polygons—that represent locations in real life. When we want 

to add certain new objects or to edit existing ones, the following are the steps: 

1. Add data by using the satellite imagery that you have learned to add nodes to the 

map you are familiar with. If you notice a mistake on that map, try correcting it.  

2. You do not need to rush when learning about a new area. If you are unsure about 

an object, it is advised not to map it. 

3. If you want to move a node, way, or polygon, use the Object Selection Tool. Click 

on an object and move it to the right place. This is to correct the location of an 

object that is mistakenly mapped. 

4. Use Drawing Tools to add new nodes, ways, and polygons. Describe these objects 

by selecting from Presets menu, which you have practiced doing in the previous 

chapter. 
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JOSM Layer 

You might have already noticed that every time you add new data on JOSM, it will be 

added on the layer panel in the right side of JOSM. Depending on what you have 

opened, layer panel will look like this. 

 

 
Picture 6.5. JOSM Layer 

 

Each item on this list is different data source that you open on your mapping window. 

In this example, “Data Layer 1” is the OpenStreetMap data we edit. “Bing aerial 

imagery” is a satellite imagery that we inserted earlier. 

 

Layers used as backgrounds to help digitizing, such as satellite imagery, GPS tracks, 

and field papers are often referred to as “base layers” while the data layer from OSM 

that we downloaded is the main layer that we use to do edits: 

1. To move a layer, click on that layer on the layer panel and switch it upwards or 

downward to move it. 

 

2. To temporarily remove a layer, click on the layer and click the Show/Hide 

button: 

 

Notes: 

Do not edit the maps outside the area you downloaded. You can see a square area you downloaded by the brighter color, 

while the area you did not download has a darker color with diagonal lines on top of it. 
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You will see that the layer you chose to hide will be removed from the map 

window. Click Show/Hide again, and the layer will appear again. 

3. You can remove a layer by selecting it from the list and press delete: 

 

4. Lastly, it is important to know that you can only do edits to layer considered active 

by JOSM. If you cannot edit the maps in your window, this is maybe because the 

layer is not active. Most layers, such as GPS nodes, Field Papers, satellite imagery, 

are not editable. The only layer that can be edited is the data from OpenStreetMap, 

which is usually named as “Data Layer 1”. To make an active layer, select from 

the layer panel, and click on Activate: 

 

 

Tag 

A tag is like a label that you can put on an object. For example, if we select a building 

in an area and apparently that building is a mosque, named “Masjid Al-Itisom”; the 

amenity is “place of worship” and it is a place of worship for the Muslims. You can add 

as many tags as you want to an object. A tag is stored as a pair of text, which are key 

and values. In OpenStreetMap, you can see all texts attached to an object from 

Tags/Memberships panel in the right side. 

 

Picture 6.6. Sample Tags from an Object in OSM 
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Editing Tags 

You can add, edit, and delete tags from Properties panel. But tags are manually 

written in English and are sometimes confusing, so it is often easier to use Preset 

menu. When you add or change tags, the object’s attributes change: 

1. To edit an object’s tags, first select the object. 

2. And then edit tag using one of the two options: (1) Using Preset Menu, or (2) 

Editing tags directly from the Tags/Memberships window on the right. 

 
 

6.1.4 Saving Changes 

The third and last step to finish and edit is to upload the changes we made into the 

OpenStreetMap database. To save changes, we need have an internet connection. 

1. Click on “File” on the upper menu, and click on “Upload Data”. This will 

command an upload window to appear. You can also access this window more 

quickly by clicking on the upload button, shown below: 

 

2. The window that appears will show the list of objects you added and the objects 

you edited. On the box below it, you are requested to type in comments about the 

changes you made and to also put in the data source of the objects you created, 

whether they are from a field survey, satellite imagery, or your personal 

knowledge. 
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Picture 6.7. Confirmation Window to Upload OSM Data 

 

3. Click “Upload Changes” 

4. You need to wait for several seconds to upload your edits, and then done! You 

have already made edits to OpenStreetMap. 

 

6.1.5 Saving OSM Files 

When you do edits in JOSM, you are advised to download, to edit, and to upload the 

changes in a short period of time. Do not hesitate to upload your changes as often 

possible. This is to ensure that your changes are stored onto the OSM server and that 

you do not lose your work. But later, there may be a case when you have not finished 

your work and you want to save the OSM file into your computer. This can be done. 

Here is how: 

1. To save an OSM file, make sure it is an active layer on the Layers panel. Click on 

“File” from the menu at the upper part of JOSM, and click “Save”. Select the 
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location where you want to save the file and name the file. You can also perform 

saving by clicking on this button:  

2. You can close JOSM and the data will be saved. When you want to open that file 

again, open JOSM and go to “File”, and click “Open…” 

 

6.1.6 Seeing the Changes You Made on the Map 

1. Open your internet browser and go to http://openstreetmap.org/ 

2. Go to the area you have mapped. 

3. You should have been able to see the changes on the map! If not, try pressing 

CTRL+R to refresh the website. The map usually has not been refreshed and need 

to reloaded.  

4. How if you cannot see the changes you created? Do not worry – it will take a few 

minutes for the map changes to take effects. You can also check your JOSM again 

to see if the steps to edit you took were correct. The common guideline is that when 

your node has an icon on JOSM, it should be visible on the main map of 

OpenStreetMap. 

 

SUMMARY 

You have learned and practiced how to add OpenStreetMap data using JOSM. Now you can 

add data changes to your map into OpenStreetMap using JOSM as often as you want. Keep 

practicing adding data edits to enhance your mapping skills. You can start by mapping the area 

surrounding your place of living or the area you are familiar with. In the next chapter, you will 

learn the importance of quality assurance to the data you add to the OpenStreetMap. 
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Chapter 7 

Data Quality Assurance on 
OpenStreetMap 

 

Learning Objectives: 

• To understand the definition of data quality assurance in OpenStreetMap 
• To understand the importance of OpenStreetMap data quality assurance 
• To understand several examples of data quality assurance tools 
• To practice quality assurance tools in JOSM 

 

7.1 What is Quality Assurance? 
 

Quality assurance is an activity where mappers, in this case OpenStreetMap 

contributors, do data checking to ensure the data on OpenStreetMap meets certain 

standards for usage and is free from data vandalism. Quality assurance activities can be 

divided into three categories: 

1. Geometry Quality Assurance 

This quality assurance category aims to ensure that the data on OpenStreetMap has 

similar forms to the ones on the field, for example: school buildings on the sattelite 

imagery must have the same shapes with the ones in real life. 

2. Attribute Quality Assurance 

This category of quality assurance aims to ensure that OpenStreetMap data has the 

same attributes/information with the ones on the field, for example: the information 

on buildings’ structures must be the same with the real building. 

3. Positional Quality Assurance 

Kategori penjaminan kualitas ini bertujuan untuk memastikan data-data yang ada 

di OpenStreetMap memiliki posisi yang sama dengan yang ada di lapangan, 
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sebagai contoh: posisi bangunan di OpenStreetMap harusnya mempunyai posisi 

yang sama seperti dengan posisi sebenarnya di lapangan. 

 

According to "Assuring the quality of volunteered geographic information”, a book 

written by Goodchild dan Li, the quality assurance for participatory mapping can 

generally be done in three mechanism, which are: 

1. Participatory 

Added by Surowiecki in his book, entitled “The Wisdom of Crowds”. Participatory 

data quality assurance has the following characteristics and strength: 

1. Several users can make common agreement on the mistake found. 

2. The observations and experiences of an individual could strengthen the 

validity of observation and experience of other individual so as to reduce the 

possibility of misunderstanding to an object. 

3. Validation and quality checking on mistakes in a certain areas can be done 

collectively so it can save time, energy, and costs in data quality assurance.  

 

2. Social 

Social Quality Assurance prioritize the individuals who do the validation. The more 

frequent a person performs validations and data checking, the more they become 

reliable to lead a group in a quality assurance activity or a project. 

One of the examples of social quality assurance done by the OpenStreetMap  is 

through the working group with each group has different topical discussions. In the 

Data Working Group, the community discusses matters related to OpenStreetMap 

data, such as data license, vandalism, conflict, and assisting in making direction to 

OpenStreetMap data use policies.  
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3. Geography (Scientific) 

The last mechanism to data quality assurance is through geography. This 

mechanism uses theoretical approaches in geography. Not all users can and are 

allowed to perform geographical quality assurance. Only the ones who have really 

understood the theories related to spatial data, such as Spatial neighbors and auto-

correlation (Moran Statistics), Inferential Statistics and Analysis of Variance 

(ANOVA), et cetera. This mechanism, therefore, is not common for a participatory 

mapping activity, especially in OpenStreetMap.  

 

7.2 The Importance of OpenStreetMap 
Data Quality Assurance 
OpenStreetMap (OSM) is one the free, open source map of the world. OSM has a lot 

of data and information on a variety of objects on the earth’s surface. All of this 

information is collected and inputted by OSM users spread all accross the world. 

Since its launch in 2004 by Steve Coast, OSM has been an alternative or even the main 

option for citizens to complete the spatial data they want. OSM’s flexibility, 

completeness, and accessibility makes it possible for its data to be used for many 

purposes, including business, technology, and social, humanitarian and disaster related 

purposes. 

This has given an upsurge to the data in OSM and will increase the data quality itself. 

As the map is open and free, OSM data quality assurance is very vital to ensure that its 

usage for public purposes in large scale can be done right and with good quality. 

Quality assurance is also important to mitigate users who intentionally alter OSM data 

or add data that are not supposed to be on the OpenStreetMap. 
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Picture 7.1. Samples of a changing road network in OpenStreetMap 

 

 

7.3 Some Samples of Data Quality 
Assurance Tools in OpenStreetMap 
Now that you know what is data quality assurance and how important it is to keep 

OpenStreetMap data quality in check. In this section, you will be introduced to some 

tools created by fellow OpenStreetMap users that can help monitor data and ensure data 

quality in OpenStreetMap. Some of the tools that can be used to ensure data quality in 

OpenStreetMap are as follows: 

1. Notes in OpenStreetMap 

Notes is one of the facilities made available by OpenStreetMap to allow users to 

give each other comments on specific objects on OpenStreetMap. Notes on objects 

are given to notify other users that there are loopholes in them, for example on a 

hospital, users can notify that the hospital is being demolished or is under 

reconstruction or that the hospital has a wrong name. What is interesting from this 

feature is that the contributor does not have to have a usernmae to add information 

to OpenStreetMap and to use the notes feature. But when you want to correct / to 

edit the object directly you have to create / login to an OpenStreetMap account.  

 

 



 

95 

Picture 7.2. OSM Interface with the Notes Feature Activated 

 

2. Who Did It 

This is a website that can more specifically help us monitor OpenStreetMap data 

in an area. This website is developed Simon Legner. The main objective of this 

website is to know entries, edits, and deletions activities on an area in 

OpenStreetMap, by putting in the username, the time of activities, the object forms, 

and the area we want. To open it, please go 

to:http://simon04.dev.openstreetmap.org/whodidit/ . 

 

Picture 7.3. Who Did It Website Interface 

 

3. OSM Inspector 

This tool is developed by Geofabrik and is often used to inspect errors in 

OpenStreetMap. To visit this website, you click on this: http://tools.geofabrik.de/osmi/. 

The following is the interface of OSM Inspector: 
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Picture 7.4. OSM Inspector Inspector 

 

7.4 JOSM Quality Assurance Tools 
JOSM is one of the most commonly used editors to contribute to the OpenStreetMap. 

One of the reasons why this is the case is because JOSM can be used offline and is its 

various features to edit a map, including to validate data. When you validate data, you 

may often find several errors and warnings.  

1. Error 

This type of mistakes need to be resolved and must not be ignored. You can not upload 

your edits if this mistakes have not been resolved. For this type of mistake, you can 

automatically resolve it by pressing Fix button. Some of the sample errors are: 

1. Duplicate nodes: this happens when there are more than one node in the same 

position. 

2. Duplicate way nodes: this happens when there are more than one way in the 

same position. 

3. Unconnected coastline: this happens when the coastline is drawn not as a closed 

/ connected ways. 

2. Warning 
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Warnings are mistakes that may need to be resolved but in some cases can be 

compromised. To resolve this type of mistakes, you need to do it manually, because it 

can not be automatically fixed by JOSM. Here are some of the examples. 

1. House number without street: this warning appears when there is a tag 

addr:housenumber but without a tag addr:street 

2. Crossing ways: this warning appears when there are ways or polygons that 

overlaps with other ways nearby. For example: building polygon that overlaps 

with the building polygon rumah next to it, or overlaps with the road.  

3. Overlaping Highways: this happens when there are two road objects with 

different types share more than one node. 

4. Similar named ways: this happens when there are ways, commonly road 

network, that share the same name. 

5. Untagged ways: this happens when there are objects (nodes, ways, polygons) 

that have not been given any attribute/presets information yet. 

6. Way end node near other highway: this warning appears when a node from an 

object is positioned very close to other objects. 

7. Crossing building: this warning is similar to the crossing ways warning. 

 

3. Using JOSM Validation Tool 

To use the validation tool in JOSM, you can click on the logo with checklist (validation) 

on the left toolbar. A validation panel will appear on the right side of JOSM. 

 

Picture 7.5. Validation Panel in JOSM 

 

Make sure no objects are selected. If you select an object, only that object will be 

validated, whilst what we aim is to validate the entire area we downloaded. Hover your 

mouse to the validation window and click Validate. JOSM will analyse all data you 
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added or changed in accordance to the validation test on the JOSM setting.  From JOSM 

default setting, all validation test will be done by JOSM. If you only want several 

validation test by JOSM, you can go to Edit – Preference and then go to the validation 

tab and untick validation tests you do not need. 

 

Picture 7.6. The List of Validation in JOSM Setting 

 

For a while your data will be analyzed. On the Validation Results window, you will see 

a list of warnings and errors, if any. Besides, on your layer panel there will be a new 

layer highlighting Validation Errors. 

 

Picture 7.7. Validation Results by JOSM 

As previously explained, you can make JOSM automatically correct errors, but nor with 

warnings, where you need to correct them one by one. To correct warning, you can click 

right on the warning and select Zoom to problem. 
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Picture 7.8. Inspecting One of the Warnings 

 

Not all warnings on JOSM need to be resolved, if you are unsure or not capable or 

resolving the issue, you can temporarily leave them as is. 

 

7.5 Tag / Information Standard in 
Indonesia 
When adding information to an object we mapped, we need to make sure the 

information is correct and is aligned with the OpenStreetMap’s rules. Therefore we 

need certain guiding standards on those objects. OpenStreetMap has provided a wiki 

for general guideline. The page is called wiki map features. You can visit them from 

http://wiki.openstreetmap.org/wiki/Map_Features. 

The following is the main interface of that page: 

 

Picture 7.9 Front Page of Wiki Map Features 
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Picture 7.10. One of the Amenities List on Wiki Map Features 

 

On map feature you can see a variety of objects that can be mapped on OpenStreetMap 

with its description and pictures. We need to remember that the objects displayed on 

map feature has universal reference and it will also show objects in foreign countries, 

such as snow cart, childcare, drinkable tap water, et cetera. Some of these objects are 

not commonly found in Indonesia and sometimes cannot be understood in local context 

by Indonesians. If you would like to search for objects specific for Indonesian context, 

you can visit the Wikipedia page made by HOT Indonesia:   

http://wiki.openstreetmap.org/wiki/Id:Referensi_Atribut_Objek_OSM_Indonesia 

 

Picture 7.11 The Reference Page for OSM Object Attributes in Indonesia 
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SUMMARY 

In this chapter you have learned about how to maintain the quality of OSM data and 

the tools for OSM data Quality Assurance. With these tools, OSM data can be made up 

to standards and can avoid the possibility data vandalism.   
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Chapter 8 

GPS Usage 
 

Learning Objectives 

 
• Understand notions and different types of GPS  
• Able to Turn on GPS 
• Perform GPS settings when first used 
• Understand the various factors that affect GPS accuracy 
• Understand defenition of Track and Waypoint 
• Collect data by GPS 
• Copy GPS data (track and waypoint) to a computer 
• Open waypoint and track in JOSM 

 

Learning to edit is one of the most important parts of mapping - how to add information 

on the field to the map. We will study some methods for conducting field surveys in 

this guide 

In this section, we will see what is GPS and how GPS work. You will learn how to 

operate a GPS and how to use it to create maps.  

Here we will explain how to operate Garmin GPSmpa 62s/64s. A GPS which 

commonly used for mapping. There are many other GPS models that can do the same, 

so if you work with a different GPS, do not worry because the principle remains the 

same. 
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8.1 Definition and GPS Parts 
A GPS works like a mobile phone, but if a mobile phone receives a radio signal from 

cellular company, GPS receives signal from the satellite surrounding the earth. By 

recieveing those signals from satelite, a GPS can calculate precisely your position on 

the surface of the earth. GPS records that location in a form of coordinates, where there 

are two long numbers. One number indicates how far your position is from East or West 

- commonly called longitude position. The second number shows how far your position 

is from North or South - usually called latitude. Every place on earth possesses unique 

geographic coordinates. 

Picture 8.1. Longitude and Latitude Illustrations 

 

GPS that will be discussed this time is GPS Garmin GPSmap 62s and 64s which use 
the same way but have slightly different specifications. Here are the Garmin GPSmap 
62s GPS parts: 
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Picture 8.2. Parts of GPS Garmin 62s 

 

 

Picture 8.3. Descriptions of the Buttons on GPS Garmin 62s 

 

8.2 Turning on GPS 
Before turning on your GPS, you should go to an open space. Because, GPS can only 

locate your location by recieving signal from satellite. GPS is not well indoor.  

Steps in turning on GPS are as follows:  
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1. Push and hold Power button which is located in the right side of GPS. Push 

power button once again to setting up screen brigthness or to view battery 

status and signals. It will look like this: 

 

 

Picture 8.4. Description of One of the Garmin 62s GPS Layout  

 

2. GPS will turn on and display satellite page. If not on the satellite page, then 

push the Page button until it displays the satellite page 

3. Satelite page will display as follows:  

 

Above pictures showing that your GPS is still looking for satellite signals. When it is 

connected to three or more satellites, the GPS will get your location. Not only 

satellite page, a home page which has been set up, are:  
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• Compass to display the direction of our survey.  

 

• A Map to display waypoint and track 

 

• Main Menu to display some other menu options  

 

8.3 Track and Waypoints 
 

Your GPS will record two types of information which is useful to create a map or to 

save coordinates from a location. First, GPS could save your location at GPS Memory. 

If you save a location, the coordinate will be saved in a specific name. For example, the 

first point saved by you will be named 001, 002, and so on. 
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When you saved a point, you can write the number on a piece of paper, with a note of 

what point it is, with attributes or indicators you want to know. A saved location in your 

GPS are called waypoint.  

Steps saving waypoint are as follows : 

 
• Push Mark button and the display will appear as follows: 

 

• Select Done to save Waypoint 

 

To view previous saved waypoint list, you can go back to Main Menu and choose 

Waypoint Manager. 

To delete a previously saved Waypoint, press Enter button to one of waypoint, then 

press Menu button and choose Delete.  

Secondly, your GPS can save things called Track. If a waypoint only save a location, a 

track will save a location series wherever you moved. For example, a track will record 

your location every second, or every one meter, and the result will be a series of dots 

showing the path of the location where you have been there previously. Track will be 

very useful to mapping an object indicated by a line or shape, such as streets, buildings, 

or field. Here are the steps in activating track recording:  
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1. Go to Main Menu, and press Setup 

 

2. Select Tracks 

 

3. At Track log, change to : Record, Show on Map 

 

4. Make sure, track recording in your GPS is active before you start your survey. 

To non-activate track recording, choose Do not Record.  

 

Tracks are saved after the field survey is completed. Generally, tracks are saved per 

day. The way to save the recorded tracks are as follows:  

1. Go to Main Menu, choose Track Manager 
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2. Choose Current Track, is a recording route you just made.  

 

3. Choose Save Track, to save a Track  

 

4. Insert track name, generally in form of date and survey time, then choose Done.  
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5. Clear the track record from previous recording, choose Yes.  

 

6. Make sure the name of the track you saved will appear. This proves that your 

survey tracks have been successfully saved. 

 

8.4 Copying Data to Computer 
 

Next, data that has been collected will be copied to a computer to use as mapping 

references. Steps are as follows:  

1. Make sure, you have installed USBDriver_231.exe to make GPS device 

readable on your computer.   

2. Connect GPS to computer by using Data Transfer Cable.  

3. Make sure GPS is turning on.  
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4. Go to Garmin GPSMAP directory, then choose folder Garmin  GPX 

 

5. Select data with your field survey data (Track & Waypoint) and copy to your computer.  

 

8.5 Opening GSM Data in JOSM  
GPS Data, that has been collected could be used as a reference to digitize using JOSM. 

This GPS data will make it easier for you to know the location of the objects that you 

have surveyed. The following are steps to open GPS Data to JOSM: 

 
1. Open your JOSM 
 
2. Choose File  Open, then select GPS data you have copied to your computer 

(Track and Waypoint),then click Open.  
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3. There will be 2 layers that appear:  

 
4. JOSM will display this:  

 
5. Open satellite imagery to display location where you survey by clicking 

Imagery  Bing Aerial Imagery  

To change colors for Track and Waypoint, you may Right Click to track layer 

or waypoint then select “Color Adjusment” and choose color you want.  

For Track, in addition to changing the color you can also change the thickness 

of the line. Same way, right click then select Customize Track Image. Change 

the number to what you want. (The bigger the number then the thicker the line)  
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6. Make sure to download OSM data before you start to digitize by click button 

 

7. You are ready to mapping according to your survey data. 

 

SUMMARY 
 
Congratulations! You have now gained an understanding of how to use GPS. If not, try 

to keep a point from several locations that you think are important. 

In this chapter, we learned how to collect waypoint and track as well as to open those 

in JOSM. Later, we will use this information to add new locaton to OpenStreetMap.  

In the next chapter, we will learn about another survey method, which is known as Field 

Paper. It allows you to create map without a GPS!  
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Chapter 9 

Field Papers 
 

Learning Objective 

• Understand how Field Papers work.  
• Create and print Field Papers 
• Add data for printing by using Field Papers 
• Complete scan and upload Field Papers to “Field Papers” sites 
• Open Field Papers into JOSM 

 

In this chapter we will see how we can record the coordinates of a place without using 

GPS. We will use a tool called Field Papers. Field Papers allows you to print map 

location on papers, to draw objects, to add notes, and to open those papers in a JOSM, 

where you can add your mapping results data into OpenStreetMap. 

9.1 Field Papers Overview 
Before we learn more about field papers, let's see an overview of how Filed Papers 

works: 

1. Search for a location you want to map in the OpenStreetMap website. Create a 

map for that location. You can select to print the map with OpenStreetMap 

background or you can print with satelitte imagery background, if the imagery is 

available in your location.  

Picture 9.1. Field Papers Landing Page 
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2. Use printed field papers to start surveying in your location. Add more places by 

drawing them on the map. Draw a way for street, polygon for building, and so on. 

Write notes from any location directly to the map or add numbers to map for 

connecting images with serial codes in notes, where you can write more detailed 

information to any objects.  

3. Scan your field papers into a computer. If you don’t have any scanner, you can take 

a photo of Field Papers, only if your camera can take pictures with high resolution. 

Upload an image to the Field Papers site.   

 

Picture 9.2. Sample of Field Papers 

4. In JOSM, add Field Papers. Use the object you have drawn as a reference to add 

those objects to a digital map inside OpenStreetMap.  

 

Picture 9.3. Sample Field Papers on JOSM 
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9.2 How Field Papers work?  
If you follow how Field Papers work, as described above, you can collect geographic 

coordinates from somewhere accurately using paper only. How could it be? 

 

Picture 9.4. Barcode Field Papers 

When you print a field paper, those papers will printed with a barcode at bottom of a 

page. This barcode allows Field Papers to determine the accurate location of the map 

you are using to conduct the survey. Then, when you add Field Papers into JOSM, all 

object you have draw will display in actual location. It is like using a GPS to collect the 

exact coordinates, unless all you need is paper! 

Now, let’s study how to make and use Field Papers.  

 

9.3 Make and Pint Field Papers  
1. Open your internet browser. In yout site adress at the top of the windo, insert 

fieldpapers.org and press Enter.  

2. Website will display like this:  
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Picture 9.5. Field Papers Landing Page 

 

3. To make a map, you may click “Make yout own Atlas” or “Make” to select 

location you wish to print.  

 

Picture 9.6. Creating Field Papers 
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4. You will directed to this page:  

 

5. In display to make an Atlas, you will found several button and menu to make 

arrangements for the map you want to create. To be clear about button function 

and how to make field papers, you can see this following image:   

 

Picture 9.7. The Page when Making Field Papers 
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Steps to make Field Papers:  

1. Title  

You can specify the title of the map you will create here. 

2. Paper size  

You can specify paper size from the map you will print later. You will adjust 

paper size into Letter, A3, or A4 Size.  

3. Paper Position/Orientation 

Paper size or orientation can be specify in this section. You can select 

Landscape or Potrait display.  

4. Map Background or basemap 

You can select map backgroun you wish to display in your paper map. 

Several option available in basemap setting, are as follows:  

• OpenStreetMap : Display a map made by OpenStreetMap  

• Satellite + labels : Display satellite imaginary and labels,        

like street name 

• Satelitte only  : Only display satelitte imaginary.  

• Humanitarian : Display a map with humanitarian themes. 

(When displaying object only related to humanitarian)  

5. Search Location 

You can search location you wish to find faster with this button. You may 

type location what location you want in this box, then press Enter.   

6. Zoom in/Zoom out Map 

Map view can be enlarged and minimized with this menu. You can zoom 

in and out by pressing the (+) and (-) keys. In addition, you can zoom in 

and out on the map by using the scroll wheel on your mouse. To move the 

map, you can use left click on your mouse. Please click and hold the left 

click button on your mouse then drag the map according to your desired 

location. 

When determining zoom level, note that your map should be able to clearly 

show the location, not too small or too large. 

7. Add/Reduce Box 
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Box we mean here is number of papers, you need to print a map. The more 

you determine the box, the more paper you need. In the example, the box 

to be printed is as much as 6 sheets of paper. 

8. Make Atlas 

If all the settings have been done, you can simply create a map by pressing 

the button “Make Atlas”. 

6. If you are done, setting up in a paper map you wish to create, then next step is to 

print the map. After you push button “Make Atlas”, you will directed to pages to 

show your map is under process by Server.  

 

Picture 9.8. The Map You Created is Processed by the Server  

7. When finished, a page will appear that indicates that your map has been printed. 

You can directly download the map by pressing the "Download PDF" button on 

the bottom right of your map 
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Picture 9.9. Downloadable Field Papers 

8. After the download is complete, you can open the map file. Congratulations you 

have successfully created your field papers! 

 

9.4 Using Field Papers in the Field.   
Take your Field Paper out, and use it as a guide to walk and identify new places not 

on the map. Draw lines for roads, polygons for buildings, and so on. Write notes about 

each location directly on the map, or add numbers on the map that are linked to a 

number in your notebook, where you can write more detailed information on each 

object. If you are satisfied with your additions to the paper map, then you can add them 

digitally to OpenStreetMap.    

9.5 Scan and Upload Field Papers 
Field papers are very easy if we want to do the mapping process. While it is convenient, 

it does not mean that the data we have collected from the mapping results in field 

papers can automatically fit into the OpenStreetMap server. We still need to insert our 

Field Paper into JOSM, add our information digitally, and save our changes in 

OpenStreetMap.  
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1. First step is scanning Field Paper to your computer. You can done this by instal 

scanner to your computer, scan your paper, and save as a image files. If you don’t 

have scanner, you can take picture from your Field Paper use camera. However, 

you should be careful that the photos taken are of good quality. Make sure Field 

Paper is on a flat surface and your camera is directly in front of it. Also make 

sure to include barcodes on the photo because Field Paper will not work without 

barcodes. Below are examples of images that have been scanned / photographed:  

 

Picture 9.10. Field Papers Photo 

2. After you have scanned field paper and saved in your computer, open your internet 

browser and go back to fieldpapers.org site, life previously.  

 

3. To upload your documents, you can click tab “Upload” in the left top of browser 

or click “Capture your Note” in the left bottom of your browser pages.  
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Picture 9.11. Uploading Field Papers 

4. Click “Select File” and navigate to where your scanned field papers file. After 

you find the image file you want, please click Open.   

 

5. You will be requested to wait for a few minutes to upload your field papers, 

depending on your internet connection. When the upload has finished, you will see 

your display like this: 
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Picture 9.12. Scanned Photo is Uploading into the Server 

 

 

Picture 9.13. Field Papers Upload Results 

 

9.6 Add Field Papers Plugin  
Before we open Field Papers in JOSM, we need to install the JOSM Field Papers plugin. 

The plugin adds additional functionality to JOSM. The Field Papers plugin allows us 

to open our Field Paper that has been scanned as a background, the same way to view 

satellite imagery as a background. 
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1. Open JOSM and go to Edit > Preferences 

2. Click to Plugin Tab 

3. Find Field Papers plugin and check the box next to it. Click OK. 

 

Picture 9.14. Plugin Field Papers 

4. Restart JOSM. 

 

9.7 Open Field Papers in JOSM 
Now you can open your Field Paper in JOSM and use to add information you have 

collect to OpenStreetMap. Back to Field Paper sites, by typing fieldpapers.org to 

your internet browser, like before.  

1. Click Tab “Watch” and then Click “Snapshot” 

2. Find your field papers in the list and click. You will view display like this:  

 

Picture 9.15. Uploaded Field Papers 

 

3. To open field papers on JOSM, we need to copy ID pictures from the field 

papers you have scanned before. Then, in the search bar at the top of your 
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internet browser, choose text and press CTRL + C on your keyboard and copy. 

The text should look the same like this: 

http://fieldpapers.org/snapshot.php?id=fdsbgzns#17/-6.20049/106.82533 

 

Picture 9.16. Uploaded Field Papers Copy Link 

4. On the top menu of JOSM, click "Field Papers". Then click on "Scanned Map ..."

 

Picture 9.17. Field Papers Menu on JOSM 

5. Press CTRL+V in your keyboard to paste text you have copied from Field Papers 

site.  

 

Picture 9.18. Inserting Field Papers on JOSM 

6. Press OK 

7. If everything working well, you should see your Field Paper open in JOSM. In the 

next chapter, we'll see how to add the places you map in OpenStreetMap. 
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Picture 9.19. Field Papers Results on JOSM 

 

You can also use Field Paper that you have scanned in other online OSM editors such 

as iD or Potlatch2 by clicking the "Edit in iD" or "Edit in Potlatch" link on the Scanned 

Field Papers page. 

 

   Picture 9.20. Field Papers Editing on iD Editor 
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Picture 9.21. Field Papers on iD Editor 

 

Let’s Try!  

After you add the data in OSM, those data will be saved to OSM map. If you wish to 

add new data from previous map, You can print a Field Paper that includes changes to 

the data you create. Repeat this process as much as possible. The more often you map, 

the better the results you'll get!  

SUMMARY 

Congratulations! In this chapter you have learned the process to use Field Papers and 

how they work. You have studied how to print, to map, and to scan a field paper and 

how you can use them to improve OpenStreetMap. Next, you can learn how to solve if 

data conflict in OpenStreetMap. 
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Chapter 10 

Solving Data Conflict in 
OpenStreetMap 

 

Learning Objective 

• To understand definition from data conflict OSM to JOSM  

• To understand types of data conflict in JOSM 

• To figure out and to practice how to fix data conflict in JOSM 

• To understand how to avoid data conflict in JOSM 

10.1 Definition of data conflict OSM in 
JOSM 
Sometimes, when you are working in JOSM and when you upload an edited map, you 

will receive messages like this:  

          Picture 10.1 Conflicts on JOSM 

 

Those messages appear when you have a data conflict in OpenStreetMap. This is 

happening when you download OpenStreetMap data to show in JOSM, and then when 

you're editing, someone else also downloads the same area as you change it, and save 

the changes to OpenStreetMap. So when you try to upload data with your version, the 

server will read different data from the data you send with the one already saved in 
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OSM first. So the server will reject the data you send and give a warning to JOSM 

because the server does not know which version of the incoming data that should be 

saved into the server. 

 

Picture 10.2. An Illustration of What Causes Data Conflict on OpenStreetMap. There are Three Users Editing the Same Place.  

 

10.2 Types of data conflict in JOSM  
Now you already know what data conflicts are inside OpenStreetMap and how it can 

happen. Conflict in JOSM does not only happen to one type of object, but it can happen 

to other objects that you change or add. There are 3 types of conflicts that are often 

encountered in JOSM, i.e.: 

1. Properties Conflict   

It is a conflict that is seen based on the position of an object, can be a node, way or 

polygon. 
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Picture 10.3. Properties Conflict Illustration. 

 

In the picture above is an example of the conflict properties. Initial version of data 

downloaded from OSM, the position of a circular object is right in the middle of the 

line. User A, which in this case is someone else, moved the object slightly towards the 

South. While the OSM data version that User B uses, the object is moved slightly 

towards the North. User A first uploads the data into the server, so that the version of 

the object on the server in accordance with the position of objects that exist in User A. 

When User B tries to upload the data into the server, the server will see a change in the 

same object but with the position different, this is what will cause data conflicts for the 

object. 

 

Picture 10.4. Red Color Signifies the Objects Have Conflicts  
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2. Tags conflict  

It is a conflict, where there are different attributes information from the same object. 

The difference can be in the value or even the key of the object: 

Picture 10.5. Tags Conflict Example 

 

In the picture above, different information viewed from key amenity and value. 

Although the object is the same object, but the information inside is equally different. 

Object in the user A, have amenity information = Police, while in the user B the object 

is amenity=cinema. When uploaded, conflict will appear and it will look like this: 

Picture 10.6. Tag Difference between Server and Local Computer  
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3. Nodes Conflict 

This conflict happens when an object consists of several points receiving addition or 

deletion from those objects which cause sequential change from a point who made those 

objects.  

 

Picture 10.7. Node Conflict Illustration 

 

If you see the picture above, in the beginning a line have point sequences in the number 

of 1-5. Then, there are two users who downloaded the object with the same version. 

User A, download those ways and delete point number 5 and add point number 13. 

After that, User A will upload the data in the server. Meanwhile, user B delete point 

number 3 and add point number 6. When user B try to upload those data to server OSM, 

server will reject those data and conflict node happen.  

 

Picture 10.8. Nodes Conflict Illustration on JOSM 
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10.3 How to Solve Data Conflict in 
JOSM 
The process of solving conflicts are quite simple in JOSM, altough can initially be 

confusing. Basically, for all conflicts that occur, JOSM will provide two options - your 

version object and another version of different person residing on the server. You must 

choose whether you want to keep using your version or the new version on the server. 

 

Picture 10.9. Select Synchronization of All Datasets to Check All Data in Server   

When conflict window appears, you may most likely select the button “Only 

Sincronize” in the beginning. But if you select this option, you may receive conflict 

message continously.  Therefore, you should select the "Syncronize all dataset..." 

button so that you can resolve conflicts at once. 

 

Picture 10.10. List of Conflict after Selecting ‘Syncronizing All Datasets’ 

Conflict only appears from two different edits at the same time. If there are three or 

more conflict exist, then conflict chain will appear simultaneously. While you can only 

choose or combine two conflicts at the same time. You can choose your version, another 

version, or combine both. 
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Picture 10.11. The Column on the Right is the Object Status on the Server  

 

The conflict messages may seem complicated, but it is actually simple. Conflict at the 

above example according to properties, the object position in earth surface. On the 

above example, if you feel confident that your version is the most appropriate version, 

you can click arrow in your version, then join into Merged Version or an improved 

version. 

 

Picture 10.12. The Green Color Means Conflict is Resolved Properly 
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Once you have selected which version you think best, then click “Apply Settlement”. 

After completing a conflict you can resolve another conflict until the conflict list is no 

longer visible and you can start uploading your changes. 

The same applies to conflict types in tags/attribute information. In this type of conflict 

you will be given a comparison between existing data on the server with existing data 

on your computer. You will be asked to choose which information you think is correct. 

If you feel that the attribute information you entered is the correct information, select 

that information into the aggregated version and the select “Apply Settlement”. 

There is a difference in resolving the type of conflict on the node. This type of conflict  

looks more complicated because of the many colors that appear on the conflict window 

display. But if you understand the explanation that will be explained below, of course, 

the settlement of conflicts on this node will be easier.  

Picture 10.13. The colors in the node conflict show different intentions 

As mentioned earlier (sub-chapter on types of conflict). This conflict occurs when a 

user changes a sequence of an existing line in OpenStreetMap. If you notice in the 

picture above, there are 3 types of colors for the type of node/point conflict. Each color 
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has a different meaning. The green color indicates that the node has not changed 

(nodes/dots numbered 1&2). The red color indicates that the node is an additional node 

that exists only in each version of the data (either server version or version on your own 

computer). As for the orange color means that the node/point is changing the position 

of the sequence. 

To solve it we can combine the existing data on the server with existing data on our 

computer or we can also use the existing data on us/server as a whole. 

All conflicts that appear on your JOSM must be completed because you will not be 

able to upload your changes until the list of all existing conflicts is resolved. 

 

10.4 How to Avoid Data Conflict in 
JOSM 
 

You certainly do not want to experience conflicts when you make changes or additions 

to OSM data. There are several ways you can minimize the conflict. 

1. Upload your change result periodically 

To minimize the occurance of a number of conflicts, it is important to upload your edits 

regularly. Conflict appears more for those who edit their entire territory first and delay 

to upload it. The best thing is, download the area you’re working on, making changes 

or add data, then upload as quickly as possible. 

The longer the time lag between downloading the data by uploading the change, the 

more likely it is that someone has edited/changed the data at that time. If you are forced 

to delay uploading data that you have modified, before you upload, you must first check 

the condition of the data by clicking on the “Update Data” button in the “File” menu. 



 

138 

 

Picture 10.14. Update the existing data in the File menu 

 

2. Only make changes and add data to the area you download 

Changing and adding data in specific areas can reduce the risk of conflict. You must 

be sure that you are not editing outside the area you have downloaded and you are 

sharing based on Task Manager. This step can avoid many users editing the same area. 

You can easily see where the outside area of your downloaded area in JOSM, because 

the background of the outside area there are diagonal lines, not only black. 

 
Picture 10.15. The shaded area is an area that should not be edited 

 

3. Using Tasking Manager 

HOT Tasking Manager is tool or media where mapmakers can divide an area into 

multiple grids, then can work with other mapmakers to map a region in a more 

organized way. In addition to being more organized, the tasking manager is also one 

way to avoid conflict, since it does not allow more than one person to map out the same 

area. 
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The mapmakers in the area can select a box on the grid you want to map, and when 

they finish mapping, they can mark the box as completed or finished mapping. In this 

way, a team of people scattered in different regions can coordinate together to complete 

the mapping on the grid. 

 

To see how the tasking manager works, let’s take a closer look. 

 

1. Open your internet browser and open the website task.hotosm.org You will 

see a page like this. 

 
Picture 10.16. Task Manager initial view 

 

1. Click “Log in using your OpenStreetMap account ” 

 
Picture 10.17. You will be redirected to the OSM logging page 
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2. By clicking on the button, you agree to this application accessing your 

OpenStreetMap account. Click “Save Changes”. 

 
Picture 10.18. Account Authentication in Task Manager 

 

3. Now you will see a list of current projects. The lists contains projects from 

different countries where they coordinate to do the mapping. 

 
Picture 10.19. Projects in Taski Manager 

 

4. Click on one of the projects to see more information. 
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Picture 10.20. One of the display in Tasking Manager 

 

5. This page shows all the things you need to know about the project. On the left 

side of the page is a description of the mapping project and how to set it. You 

can click on the tabs to see more information. 

6. On the right side there is a grid that shows the area being mapped. 

a. The orange grid box has been mapped  

b. The green box has been mapped and has been checked by others and 

validated its data 

c. Box with yellow edges means someone else is working on a map of the 

area  

d. Other empty/gray boxes are missing or has not been mapped yet  

 

2. On the “Contribute” tab you can select the task or grid you want to work on. 

Please select a box to work on, then click “Start Mapping”. 

 

3. Then select “Edit with JOSM” (If not successful please open your JOSM and 

enable “Enable Remote Control” first). 
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Picture 10.21. Start editing in Tasking Manager 

 

You can also open the area automatically for editing using JOSM, iD Editor, Potlach 2, 

Field Papers. 

You can now edit the area using the instructions available on the project information. 

When you finish editing and uploading it to OSM server, you can go back to the tasking 

manager and add comments about the chages you made. Click “Mark task as done” to 

let other mappers know you have completed the grid box. If you can not complete the 

box, click “Stop Mapping” so that the box can be done by other mappers. 

 

Summary 

You have now learned what OpenStreetMap data conflicts are in JOSM and the types 

of data conflicts that often appear in JOSM. In addition, you have also learned how to 

resolve data conflicts and how to avoid data conflicts. Periodic uploads can minimize 

the occurance of data conflicts and the use of tasking managers is one of the 

recommended ways to avoid data conflicts and to collaborate with others in mapping 

out a place in OpenStreetMap. 
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Chapter 11 

Satellite Image Shift (Imagery 
Offset) 

 

Learning Objectives 

• To understand the definition of imagery offset 

• To practice how to fix imagery offset 

• To practice how to store an imagery offset database 

 

11. 1 What is Imagery Offset? 

Using satellite imagery is one of the common approaches used in creating 

OpenStreetMap maps. Mapmakers usually use Bing Satellites as backgrounds when 

creating their own maps or other satellite images from other parties. We have learned 

how to use satellite imagery as a background in previous activities.  

Satellite image service providers usually have georeferenced their satellite imagery, but 

some satellite images are not perfectly located. This usually occurs in montainous areas 

or hills areas, where it is very difficult to draw flat images according to the surface of 

the earth that has contours.When you display a picture in JOSM, it sometimes shifts ten 

meters or more from the real position. This is called Imagery Offset. 

We have learned that there are two ways to create maps, first by using satellite imagery 

to identify a visibility on the surface of the earth and one of them using GPS to record 

tracks and waypoints and then add them to OpenStreetMap. Lots of advantages in the 

use of satellite imagery. This will make it easy for you, the mapmaker, to see the whole 

picture, to observe some details of the image, aside from you gaining knowledge about 

the area, and it will be easy to draw roads, buildings and areas, while one of the 

advantages of GPS is not experiencing shift like a satellite image. A GPS will always 

provide the exact latitude and longitude position. One of the disadvantages is that 
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satellite signals can be disturbed by high buildings and mountains, but in this case it is 

easy to know the error. Show GPS tracks on this satellite image and compare it with 

Bing image below 

 

Picture 11.1. Satellite imagery is shifting 

That way we will know that GPS tracks are accurate and satellite imagery underneath 

is shifting. Now we will definitely ask, “if satellite imagery is shifting, how can we use 

and map accurately?”. 

11.2 Fixing the Imagery Offset 

11.2.1 Fixing the Imagery Offset in iD Editor 

A. Activate the OpenStreetMap GPS traces 

Before we check whether the satellite imagery in the area we are going to map is 

shifting or not, we need GPS track as a reference. To view GPS tracks in iD Editor, you 

can do it by: 

1. Click Background Setting which is located in right side of iD editor toolbar 
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2. Check/Enable OpenStreetMap GPS traces option 

3. This feature will display the existing GPS tracks in the OpenStreetMap 

database. If in your area there is no display of GPS track, this means that in your 

area there is no GPS track entered. 

 

Picture 11.2.  The GPS track results are derived from the OSM server 

 

B. Fix the Imagery Offset 

After you display the GPS track in the iD Editor, you can determine whether the 

satellite image in the area you want to map is shifting or not. If it turns out the satellite 

image is shifting, you can fix it by: 

1. Open the Background Setting menu located on the right toolbar of the iD 

Editor.  

2. Select sub menu Adjust Imagery Offset 
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3. Use the arrow keys to move satellite image in the direction corresponding 

to the GPS position. The number in the middle will change if you shift the 

image. 

 

4. To restore the settings you can click on the arrow button located on the 

bottom right corner, or change the offset value to 0,0. 

 

11.2.2 Fixing the Imagery Offset in JOSM 

A. Downloading GPS Track 

One of the best reference to set up satellite imagery is to use GPS tracks. The more 

GPS tracks you have, the more accurately you can fix the imagery offset. Currently 
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OpenStreetMap users often upload their GPS tracks into OSM database, we can 

download them and use them to improve the position of our satellite imagery. 

1. Click on download button 

 

2. Check the box next to “GPS Data” located at the top position of Download 

window. Select your area and click “Download”.” 

 

 

3. It will download an additional layer in JOSM which consists of GPS tracks. 

Depending on how many tracks are already uploaded by OSM users, you may 

see some tracks or even no GPS tracks at all: 

 

 

B. Fixing the Imagery Offset 

Once you have downloaded your GPS track you will probably know if your satellite 

image is shifting or not when viewed from existing GPS tracks. If you already know 

that your satellite image is shifting from position that should be the same as the GPS 

track, you can fix it by 

1. To set up satellite imagery, click on the “Set up Offset Imagery” button at the 

top of JOSM. 
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2. An image offset setting box will appear, use left click and hold on your mouse 

to move the image so that it will be positioned parallel to the GPS track. The 

GPS track must be positioned the same as the road image as close as possible. 

You will see the offset number will change in the box. 

 

Picture 11.3. Imagery Offset Setting box 

 

3. If necessary, you can save this shift setting by entering the name of the marker 

and click OK. You can then automatically apply the same settings to go to 

Imagery > Imagery Offset > and click on the bookmarks you saved. 

4. If you do not want to save the shift, click OK withouth having to enter the 

name of the marker. 

 

What if there is no GPS track in OpenStreetMap and you do not have GPS? Without 

GPS tracks, it would be very difficult to organize imagery. If it’s a relatively empty 

area, you might be able to map it first and fix it later. It would be better to map an area 

with offset than not map at all. 
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11.3 Obtain the Imagery Offset Database 

There is one alternative way to find out whether the satellite image in the area is shifting 

or not by checking the iamgery offset database (http://offsets.textual.ru/). If you find 

that your region is having imagery offset, you can use the additional tool that is 

imagery_offset_db. Through this additional device, you can check whether the area you 

are in has a database related to imagery offset or not. 

Click on Imagery > obtain imagery offset to check whether your region is having 

imagery offset or not. Otherwise, a message will appear as follows: 

 

Picture 11.4. Notification if there is no imagery offset database 

If your area does not have a imagery offset database, you can shift the satellite image 

through Imagery Offset Setting feature. 

After you successfully shift the image, you can save the image shift value into the 

imagery offset database by: 

1. Click Imagery > Saving the Imagery Offset 

 

2. Comment on the value of the imagery offset you are about to upload, the 

comment you write may be the shifting location, the reference point on which 

to shift the image, how far the shifting difference, etc. If finish, click OK 
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3. When you select Imagery > Obtain the Imagery Offset you will obtain the 

list of imagery offset database in your region as follows: 

 

 

Summary 

You now understand what a imagery offset is and how to fix imagery offset through 

both the iD Editor and JOSM. You can fix the imagery offset by downloading GPS data 

already uploaded by other users to the OSM server. However, if the data is not available, 

you may be able to map the area first. Because it would be better to map the area than 

not at all. 
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Chapter 12 

Obtain the OSM Data 
 

Learning Objectives: 

• Able to practice how to obtain OSM data in GeoFabrik 

• Able to practice how to obtain OSM data in HOT Export 

• Able to practice how to obtain OSM data in Overpass Turbo 

After you learn how to add and to edit data in OpenStreetMap (OSM), in this chapter 

we will learn how to obtain OSM data for your various needs. You can use OSM data 

as a backup of your map data or the data you can work as needed by using Geographic 

Information System software such as QGIS (www.qgis.org). 

 

12.1 Geofabrik 

If you want to obtain one country’s OSM data, you can get the data in the GeoFabrik 

website. Geofabrik is a german-made site that provides OSM data in various types for 

all countries in the world. To access it, you just need to go to Geofabrik website 

(download.geofabrik.de). 

 

Picture 12.1. Front page of  download.geofabrik.de 
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If you successfully open geofabrik website, you will be presented eight sub-regions for 

all countries in the world. The purpose of the division of the region is certainly to 

facilitate users search for their country. Indonesia can be found in the Asian section by 

clicking the Asian sub-region within the blue table. 

 

Picture 12.2. Asian region in Geofabrik 

After Asian region appears on the top page, you can see some list of countries that exist 

in Asia. To get Indonesian data, click on Indonesia country on the blue table. 

 

Picture 12.3. Indonesia region in Geofabrik 

You will see the country Indonesia with some frequently used files. To download files 

that you will use in spatial data processing software such as QGIS or ArcGIS, you can 
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download the file Indonesia-latest-free.shp.zip. To download other files commonly 

used for Osmosis, Osmium, osm2pgsql, etc. Please download the file named Indonesia-

latest.osm.pbf. 

For spatial files, when you extract the file you will be presented several files of type 

point, line, and polygon. You can also see the date the data was created. Usually 

Geofabrik update every 24 hours, so if you upload data in OSM, you will not be able 

to get the data automatically but you have to wait the following day to be able to 

download data from server. To download the old data, Geofabrik only provides data for 

the last two months. To get it you can click the raw directory index option. 

 

12.2 HOT Exports 

You currently know how to download OpenStreetMap data for one country. But what 

if you want to download OpenStreetMap data for a specific region? Is there a tool to 

download OpenStreetMap data for a specific region? 

The answer to that question is to use HOT Exports. With tools developed by HOT, we 

can download specific OpenStreetMap data for the region we want. However, through 

HOT Exports we can not download regions like America, Europe, and Australia, 

because currently HOT Exports only supports some areas only. 

 

Picture 12.4. Areas that supported by HOT Exports  
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By using HOT Exports we can also get some types of file like shp, garmin, google 

earth kmz, obf, and sql. To use it: 

1. Open website export.hotosm.org it will appear the front page of HOT Export. 

Click Login to OpenStreetMap to start exporting data using your OSM account. 

 

Picture 12.5. Front page view of HOT Export 

 

2. If you have successfully signed in using OpenStreetMap account, you can 

immediately start selecting the region you want to download by dragging the 

map to the right to where you want and create a box by clicking on Select Export 

Area. To create a box, it’s the same way to download OpenStreetMap data using 

JOSM, left click and hold your mouse on the map and create the area box youw 

want to download. 

 

Picture 12.6. Create a new Area in HOT Exports 
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3. Enter the export name you want to create. Export name is better if the area to 

be downloaded. For the description section fill in the description of the export 

needs of the area. 

 

4. After that click on the File Formats tab. In this section you are asked to specify 

the file format you want to get. You can just select all types of files but this will 

certainly result in a longer process than by selecting the files you need. 
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5. After selecting the file type you want to download, please click on the next tab 

that is Tree Tag. In this tab you will select two data model types, namely 

Humanitarian Data Model (HDM) or OSM Data Model. If you select HDM, 

this means that data that will be processed by HOT Exports is data that has links 

to disaster goals, such as places of worship, disaster sites, health sites, 

residential land use, etc. If you select the OSM data model, the data that will be 

processed by HOT Exports are general data in OpenStreetMap, such as dams, 

coastlines, relationships, all amenities and facilities, all road networks, and etc.

 

6. After that you can click the next Tab, Preset File. On this tab you can upload 

your own preset and use them to download specific data that suits your presets. 

Notes: 

ESRI SHP (OSM Schema): if you select this file, HOT Exports will present all 
attribute data which available in OSM into 3 file types (polygons, dots, and lines) 

ESRI SHP (Thematic Schema): if you select this file, HOT Exports will divide 
the OSM data into the corresponding dataset with the theme (road network, amenity, 
etc.). This type of choice will also divide the OSM data into 3 file types (polygones, 
dots, and lines). 

Garmin Map: an image suitable for your GPS. The contents of this files are 
routing, road network information, map elements, and map labels. 

Google Earth KMZ: this is a compressed file of kml files commonly used for 
Google Earth. 

OSMAnd OBF: OSMAnd is a navigation app that runs on Android and iOS that 
supports offline maps and directions. 

SQlite SQL: if you want to enter OSM data into database processing software 
like MySQL or PostgreSQL, you can enable this option. 
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If you do not have a preset file, you can ignore it by going to the next tab of 

Export Details. 

 

7. In the Export Details tab, you will see a summary of your export activities as 

well as additional options for your export. The additional options is whether you 

want to save your export area privately or publicly, and publicly publish your 

exports. If you already agree with your export settings, click the Create Export 

button located below your export summary. 

Then the server will directly process your request. The process depends on the size 

of the area you choose and also the server’s capacity. All exports requests either you 

made or other users made will appear on the “Exports” page. 

 

Picture 12.7. Export View completed in HOT Export 
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12.3 Overpass-turbo 

If you only need one object in the OSM data, then the right choice is to use Overpass 

Turbo site. Suppose you only need a school object for the area of Jakarta and 

surrounding areas. How to download OpenStreetMap data using turbo overpasses are: 

1. Open your browser and type http://overpass-turbo.eu/ 

2. You can start doing a location search that you want to download on the 

OpenStreetMap Slippy Map located on the right. You can pan and zoom the 

map with a sign (+) and zoom out the map with a sign (-). You can do a search 

directly by typing in the search box as below, for example Jakarta. There will 

be several areas related to Jakarta, you can choose the one corresponding to 

the region you want to download. 

Picture 12.8. Initial View of Overpass Turbo 

4. If you do not want to download OpenStreetMap data across Jakarta, you can 

zoom out the area and draw the boundaries to be downloaded by clicking 

"manually select box" in the toolbar on the left of the map. Draw a box that 

you customize with the region. 
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Picture 12.9. Creating squares area manually 

5. Next to download OSM data based on one object e.g. school, you click Menu 

Wizard. In the Wizard menu, you can filter the data by using the JOSN Query, 

can simply be tags that consist of Key and Value on the object, such as school 

then write in the wizard of amenity = school. 

 

Picture 12.10. Query box in Overpass Turbo 

6. Click Build and Run Query, wait a few minutes until the selected school object 

in the region appears, as the picture below will show the whole school object 

with all data types in OSM. 
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Picture 12.11. School Object Search Result 

 

7.  If you only want the data type in the form of point / node. You can edit in the 

Query box on the left how to remove school with type way and relation, then 

click Run menu located at top left. The result is a school object with a point 

data type that will be filtered. You can also add other more detailed queries in 

the box and click Run. 

 

Picture 12.12. Delete some queries in Overpass Turbo 

3. To download the school data you can click Export Menu, there are several data 

formats that you can choose such as geoJSON, GPX, KML, .osm format, etc. If 

you are not familiar with geoJOSN, you can choose level0 to download the .osm 

data format that you can later use by using QGIS or other mapping software. 
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Picture 12.13. Export Overpass Turbo Results 

 

Summary 

You have now been able to find out how to get OpenStreetMap data with Geofabrik, 

HOT Export and Overpass-turbo. Geofabrik allows you to retrieve OpenStreetMap data 

for one country, while HOT Export allows you to retrieve data for one region you want. 

If you want to retrieve only specific data on a particular tag, you can use overpass-turbo 

as the data retrieval medium. 

 


